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  Introduction
Introduction

Thank you for purchasing an NA-series Programmable Terminal.

This manual contains information that is necessary to use the NA-series Programmable Terminal. 
Please read this manual and make sure you understand the functionality and performance of the 
NA-series Programmable Terminal before you attempt to use it in a control system.

Keep this manual in a safe place where it will be available for reference during operation.

This manual is intended for the following personnel, who must also have knowledge of electrical sys-
tems (an electrical engineer or the equivalent).

• Personnel in charge of introducing FA systems.

• Personnel in charge of designing FA systems.

• Personnel in charge of installing and maintaining FA systems.

• Personnel in charge of managing FA systems and facilities.

This manual covers the following products.

• NA-series Programmable Terminals

Intended Audience

Applicable Products
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   Relevant Manuals
Relevant Manuals

The basic information required to use an NA-series PT is provided in the following three manuals.

• NA-series Programmable Terminal Hardware User’s Manual (Cat. No. V117)

• NA-series Programmable Terminal Software User’s Manual (Cat. No. V118)

• NA-series Programmable Terminal Device Connection User’s Manual (Cat. No. V119)

Operations are performed from the Sysmac Studio Automation Software.

Refer to the Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for information on the Sys-
mac Studio.

Other manuals are necessary for specific system configurations and applications.

The following manual is also available to walk you through installations and operations up to starting 
actual operation using simple examples.

Refer to it as required.

• NA-series Programmable Terminal Startup Guide Manual (Cat. No. V120)
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  Manual Structure
Manual Structure

The following page structure is used in this manual.

Note This illustration is provided only as a sample. It may not literally appear in this manual.

Page Structure and Markings

Level 1 heading

Level 2 heading

Level 3 headingLevel 2 heading

A step in a procedure

Manual name

Special information

Level 3 heading

Page tab

Give the current 
headings.

Indicates a procedure.

Icons indicate precautions, 
additional information, or 
reference information.

Gives the number 
of the main section.

3 - 5

3   Installation and Wiring
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3-3 Installing NA-series PTs

The NA-series PT is installed by embedding it in a control panel. Panel Mounting Brackets and a Phillips screwdriver are 
required to mount the NA-series PT. The required number of Panel Mounting Brackets are included with the NA-series PT.

 

Use the following installation procedure.

1 Open a hole in which to embed the NA-series PT with the following dimensions and insert the 
NA-series PT from the front side of the panel.

 

Additional Information

You can use an NS-USBEXT-1M USB Relay Cable to extend the USB slave connector on the 
back panel of the NA-series PT to the front surface of a control panel. If you use the USB Relay 
Cable, open a hole with the following dimensions and install the Cable.

2 Attach the panel mounting brackets from the back of the panel as shown in the following figure.

The number of mounting brackets depends on the size of the NA-series PT, as shown in the following 
table. Refer to Bracket Mounting Locations for Different NA-series PT Sizes on page 3-8, below.

Catch the brackets in the mounting holes in the NA-series PT, pull forward lightly, and then use 
a Phillips screwdriver to tighten the screws and secure the NA-series PT to the panel, which will 
be held between the mounting brackets and the NA-series PT.

3-3-1 Installation in a Control Panel

Installation in a Control Panel

Model Dimensions

NA5-15W 392 +1/-0 × 268 +1/-0 mm (horizontal × vertical)

NA5-12W 310 +1/-0 × 221 +1/-0 mm (horizontal × vertical)

NA5-9W 261 +1/-0 × 166 +1/-0 mm (horizontal × vertical)

NA5-7W 197 + 0.5/-0 × 141 +0.5/-0 mm (horizontal × vertical)

Model Number of Panel Mounting Brackets

NA5-15W 8 locations

NA5-12W 6 locations

NA5-9W 4 locations

NA5-7W 4 locations

Panel Mounting Bracket Phillips screwdriver

Vertical

Horizontal

Recommended panel thickness: 1.6 to 6.0 mm
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   Manual Structure
Special information in this manual is classified as follows:

Precautions for Safe Use

Precautions on what to do and what not to do to ensure safe usage of the product.

Precautions for Correct Use

Indicates precautions on what to do and what not to do to ensure proper operation and perfor-
mance.

Additional Information

Additional information to read as required.

This information is provided to increase understanding or make operation easier.

Version Information

Information on differences in specifications and functionality with different versions is given.

Special Information
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Terms and Conditions Agreement

 Exclusive Warranty

Omron’s exclusive warranty is that the Products will be free from defects in materials and workman-
ship for a period of twelve months from the date of sale by Omron (or such other period expressed in 
writing by Omron). Omron disclaims all other warranties, express or implied.

 Limitations

OMRON MAKES NO WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED, ABOUT 
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OF 
THE PRODUCTS. BUYER ACKNOWLEDGES THAT IT ALONE HAS DETERMINED THAT THE 
PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR INTENDED USE.

Omron further disclaims all warranties and responsibility of any type for claims or expenses based 
on infringement by the Products or otherwise of any intellectual property right.

 Buyer Remedy

Omron’s sole obligation hereunder shall be, at Omron’s election, to (i) replace (in the form originally 
shipped with Buyer responsible for labor charges for removal or replacement thereof) the non-com-
plying Product, (ii) repair the non-complying Product, or (iii) repay or credit Buyer an amount equal 
to the purchase price of the non-complying Product; provided that in no event shall Omron be 
responsible for warranty, repair, indemnity or any other claims or expenses regarding the Products 
unless Omron’s analysis confirms that the Products were properly handled, stored, installed and 
maintained and not subject to contamination, abuse, misuse or inappropriate modification. Return of 
any Products by Buyer must be approved in writing by Omron before shipment. Omron Companies 
shall not be liable for the suitability or unsuitability or the results from the use of Products in combi-
nation with any electrical or electronic components, circuits, system assemblies or any other materi-
als or substances or environments. Any advice, recommendations or information given orally or in 
writing, are not to be construed as an amendment or addition to the above warranty.

See http://www.omron.com/global/  or contact your Omron representative for published information.

OMRON COMPANIES SHALL NOT BE LIABLE FOR SPECIAL, INDIRECT, INCIDENTAL, OR CON-
SEQUENTIAL DAMAGES, LOSS OF PROFITS OR PRODUCTION OR COMMERCIAL LOSS IN ANY 
WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS BASED IN CONTRACT, 
WARRANTY, NEGLIGENCE OR STRICT LIABILITY.

Further, in no event shall liability of Omron Companies exceed the individual price of the Product on 
which liability is asserted.

Warranty, Limitations of Liability

Warranties

Limitation on Liability; Etc
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   Terms and Conditions Agreement
Omron Companies shall not be responsible for conformity with any standards, codes or regulations 
which apply to the combination of the Product in the Buyer’s application or use of the Product. At 
Buyer’s request, Omron will provide applicable third party certification documents identifying ratings 
and limitations of use which apply to the Product. This information by itself is not sufficient for a com-
plete determination of the suitability of the Product in combination with the end product, machine, sys-
tem, or other application or use. Buyer shall be solely responsible for determining appropriateness of 
the particular Product with respect to Buyer’s application, product or system. Buyer shall take applica-
tion responsibility in all cases. 

NEVER USE THE PRODUCT FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR 
PROPERTY WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO 
ADDRESS THE RISKS, AND THAT THE OMRON PRODUCT(S) IS PROPERLY RATED AND 
INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Omron Companies shall not be responsible for the user’s programming of a programmable Product, or 
any consequence thereof.

Data presented in Omron Company websites, catalogs and other materials is provided as a guide for 
the user in determining suitability and does not constitute a warranty. It may represent the result of 
Omron’s test conditions, and the user must correlate it to actual application requirements. Actual perfor-
mance is subject to the Omron’s Warranty and Limitations of Liability.

Product specifications and accessories may be changed at any time based on improvements and other 
reasons. It is our practice to change part numbers when published ratings or features are changed, or 
when significant construction changes are made. However, some specifications of the Product may be 
changed without any notice. When in doubt, special part numbers may be assigned to fix or establish 
key specifications for your application. Please consult with your Omron’s representative at any time to 
confirm actual specifications of purchased Product.

Information presented by Omron Companies has been checked and is believed to be accurate; how-
ever, no responsibility is assumed for clerical, typographical or proofreading errors or omissions.

Application Considerations

Suitability of Use

Programmable Products

Disclaimers

Performance Data

Change in Specifications

Errors and Omissions
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  Safety Precautions
Safety Precautions

The following notation is used in this manual to provide precautions required to ensure safe usage of 
the NA-series Programmable Terminal. The safety precautions that are provided are extremely impor-
tant to safety. Always read and heed the information provided in all safety precautions.

The following notation is used.

Definition of Precautionary Information

Precautions for Safe Use
Indicates precautions on what to do and what not to do to ensure safe usage of the product.

Precautions for Correct Use
Indicates precautions on what to do and what not to do to ensure proper operation and performance.

Symbols

The circle and slash symbol indicates operations that you must not do.

The specific operation is shown in the circle and explained in text.

This example indicates prohibiting disassembly.

The triangle symbol indicates precautions (including warnings).

The specific operation is shown in the triangle and explained in text.

This example indicates a general precaution.

WARNING

Caution

Indicates a potentially  hazardous situation which, if 
not avoided, could result in mild or moderate injury or 
at the worst, serious injury or death. Additionally, 
there may be severe property damage.

Indicates a potentially hazardous situation which, if not 
avoided, may result in minor or moderate injury, or 
property damage.
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   Safety Precautions
Warnings

Do not attempt to take the NA Unit apart and do not touch the product inside while the 
power is being supplied. Otherwise it may result in electric shock.

Always ensure that the personnel in charge confirm that installation, inspection, and 
maintenance were properly performed for the NA Unit. “Personnel in charge” refers to 
individuals qualified and responsible for ensuring safety during machine design, 
installation, operation, maintenance, and disposal.

Ensure that installation and post-installation checks are performed by personnel in charge 
who possess a thorough understanding of the machinery to be installed.

Do not use the input functions such as the touch panel or function keys of the NA Unit, in 
applications that involve human life, in applications that may result in serious injury, or for 
emergency stop switches.

Do not attempt to disassemble, repair, or modify the NA Unit. It may cause NA Unit to lose 
its safety function.

Never press two points or more on the touch panel of the NA Unit at a time. Touching two 
points or more interrupts normal touch panel operations.

WARNING
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Precautions for Safe Use

• When unpacking the NA Unit, check carefully for any external scratches or other damages. Also, 
shake the NA Unit gently and check for any abnormal sound.

• The NA Unit must be installed in a control panel.

• The mounting panel must be between 1.6 and 6.0 mm thick. Tighten the Mounting Brackets evenly to 
a torque of between 0.5 and 0.6 N·m to maintain water and dust resistance. If the tightening torque 
exceeds the specified value, or the tightening is not even, deformation of the front panel may occur. 
What is more, make sure the panel is not dirty or warped and that it is strong enough to hold the NA 
Unit.

• Do not let metal particles enter the NA Unit when preparing the panel.

• Turn OFF the power supply before connecting or disconnecting cables.

• Periodically check the installation conditions in applications where the NA Unit is subject to contact 
with oil or water.

• Be certain to use the cables with lock mechanism such as serial cable or the Ethernet cable after 
confirming if it is securely locked.

• Do not touch the packaging part of the circuit board with your bare hands. Discharge any static elec-
tricity from your body before handling the board.

• Do not use volatile solvents such as benzene and thinners or chemical cloths.

• Water and oil resistance will be lost if the front sheet is torn or is peeling off. Do not use the NA Unit, 
if the front sheet is torn or is peeling off.

• As the rubber packing will deteriorate, shrink, or harden depending on the operating environment, 
periodical inspection is necessary.

• Confirm the safety of the system before turning ON or OFF the power supply, or pressing the reset 
switch.

• The whole system may stop depending on how the power supply is turned ON or OFF. Turn ON/OFF 
the power supply according to the specified procedure.

• Operate DIP switch according to the following way.

The DIP switch may break if it is levered with a tool against the case as shown in the figure.

• Once the DIP switch settings are changed, reset by pressing the reset switch, or restart the power 
supply.

• Initialize the project, after confirming that existing project is backed up at the Sysmac Studio.

• When changing the password, do not reset or turn OFF the power supply until the writing is com-
pleted. A failure to store the password may cause the project to fail to function.

• While uploading or downloading a project or a system program, do not perform the operations as fol-
lows. Such operations may corrupt the project or the system program:

• Turning OFF the power supply of the NA Unit

• Resetting the NA Unit.

• Removing the USB devices or SD card.

• Disconnecting the cable between a support tool and the NA Unit.

• Do not connect an AC power supply to the DC power terminals.

• Do not perform a dielectric strength test.

Back of the case

DIP switch

Correct technique Incorrect technique
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   Precautions for Safe Use
• Use a DC power with a slight voltage fluctuation and that will provide a stable output even if the input 
is momentarily interrupted for 10 ms. Also use the one with reinforced insulation or double insulation.

Rated Power Supply Voltage: 24VDC (Allowable range 19.2 to 28.8VDC)

• Use a power cable with AWG#12 to #22 thick (0.35mm2 to 3.31mm2). Peel the coating 7mm length 
and tighten the terminal screw with the torque in the range of 0.5 to 0.6 N·m. Also confirm if the termi-
nal screw is tighten appropriately.

• To prevent malfunctions caused by noise, ground the NA Unit correctly.

• Do not use any battery if strong impact is applied to it (e.g. by dropping on the floor) because such a 
battery may cause a leakage.

• Confirm the type of the battery to install the battery properly.

• Apply power for at least five minutes before changing the battery. Mount a new battery within five 
minutes after turning OFF the power supply. If power is not supplied for at least five minutes, the 
clock data may be lost. Check the clock data after changing the battery.

• Do not dismantle a battery nor let it short-circuit.

• Do not apply an impact with the lithium battery, charge it, dispose it into a fire, or heat it. Doing either 
of them may cause an ignition or a bursting.

• Dispose of the NA Units and batteries according to local ordinances as they apply.

• The following precaution must be displayed on all products containing lithium primary batteries with a 
perchlorate content of 6ppb or higher when exporting them to or shipping them through California, 
USA.

Perchlorate Material - special handling may apply.

See www.dtsc.ca.gov/hazardouswaste/perchlorate

The NA-Series contains a lithium primary battery with a perchlorate content of 6ppb or higher. When 
exporting a product containing the NA-Series to or shipping such a product through California, USA, 
label all packing and shipping containers appropriately.

• Do not connect the USB devices in the environment subject to the strong vibration.

• Do not connect USB devices which are not allowed to connect to NA Unit.

• Start actual system application only after checking normal operation of the system including storage 
devices such as USB memory and SD card.

• When connecting peripheral devices which do not meet the performance level of the NA Unit for 
noise and static electricity, ensure sufficient countermeasures against noise and static electricity dur-
ing installation of the peripheral devices to the NA Unit.

• Do not carry out the following operations when accessing USB devices or SD card:

• Turning OFF the power supply of the NA Unit

• Press the Reset switch of the NA Unit

• Pull out the USB devices or SD card

• When using the No. 6 pin of the serial port connector for a voltage of DC+5V, make sure the supply 
equipment's current capacity is below 250mA before using it. The DC+5V voltage output of the NA 
Unit is +5V±5%, and the maximum current is 250mA.

• To ensure the system's safety, make sure to incorporate a program that call periodically signals dur-
ing the operation at connected device side and can confirm the normal functionality of the NA Unit 
before running the system.

• Start actual system application only after sufficiently checking project, subroutine and the operation of 
the program at the connected device side.

• To use numeric input functions safely, always make maximum and minimum limit settings.

• Do not press the touch panel with a force greater than 30 N.

• Do not use hard or pointed objects to operate or scrub the screen, otherwise the surface of the 
screen may be damaged.
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  Precautions for Safe Use
• The deterioration over time may cause the touch points to move on the touch panel. Calibrate the 
touch panel periodically.

• A touch position detection error of approximately 20 pixels may occur due to the precision of the 
touch panel. Always take this into account when positioning objects on the panel so adjoining objects 
will not be activated by mistake.

• Confirm the safety of the system before pressing the touch panel.

• Do not accidentally press the touch panel when the backlight is not lit or when the display does not 
appear or is too dark to identify visually.

• You can change the brightness by changing the setting such as in the system menu or by download-
ing project. 
If the brightness is set to very dark, it causes flickering or unreadable screen. Additionally, the bright-
ness can be restored by transferring the project again after setting the property of the brightness 
appropriately. 
In a case of the applications where end users can control the brightness, create the applications so 
as keeping on operations by such as assigning the function which restores the brightness to one of 
function keys, if necessary.

• Signals from the touch panel may not be entered if the touch panel is pressed consecutively at high 
speed. Make sure to go on the next operation after confirming that the NA Unit has detected the input 
of the touch panel.

• The function keys have the restrictions as follows:

• Using both anti-reflection sheet and protective cover interrupts the normal function key operation. 
Do not use them together.

• When you use gloves or others, the function keys may not work correctly depending on the mate-
rial and thickness of the gloves. Take actual conditions of the gloves usage into considerations 
prior to the system startup to perform the confirmation.

• The function keys do not work when covered with water. Remove the water completely before 
use.
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   Precautions for Correct Use
Precautions for Correct Use

 Do not install or store the NA Unit in any of the following locations:

• Locations subject to severe changes in temperature

• Locations subject to temperatures or humidity outside the range specified in the specifications

• Locations subject to condensation as the result of high humidity

• Locations subject to corrosive or flammable gases

• Locations subject to strong shock or vibration

• Locations outdoors subject to direct wind and rain

• Locations subject to strong ultraviolet light

• Locations subject to dust

• Locations subject to direct sunlight

• Locations subject to splashing oil or chemicals

 Take appropriate and sufficient countermeasures when installing systems in 
the following locations:

• Locations subject to static electricity or other forms of noise

• Locations subject to strong electric field or magnetic field

• Locations close to power supply lines

• Locations subject to possible exposure to radioactivity
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Regulations and Standards

• EMC Directive

 EMC Directive

OMRON devices that comply with EC Directives also conform to the related EMC standards so that 
they can be more easily built into other devices or the overall machine. The actual products have 
been checked for conformity to EMC standards.*

Whether the products conform to the standards in the system used by the customer, however, must 
be checked by the customer. EMC-related performance of the OMRON devices that comply with EC 
Directives will vary depending on the configuration, wiring, and other conditions of the equipment or 
control panel on which the OMRON devices are installed. The customer must, therefore, perform 
the final check to confirm that devices and the overall machine conform to EMC standards.

* Applicable EMC (Electromagnetic Compatibility) standards are as follows:  
EMS (Electromagnetic Susceptibility): EN 61131-2:2007 
EMI (Electromagnetic Interference): EN 61131-2:2007

 Conformance to EC Directives

The NA-series PTs comply with EC Directives. To ensure that the machine or device in which the 
NA-series PT is used complies with EC Directives, the NA-series PT must be installed as follows:

• The NA Unit must be installed within a control panel.

• You must use reinforced insulation or double insulation for the DC power supplies connected to 
the NA Unit.

• NA-series PTs that comply with EC Directives also conform to the Common Emission Standard 
(EN 61000-6-4). Radiated emission characteristics (10-m regulations) may vary depending on the 
configuration of the control panel used, other devices connected to the control panel, wiring, and 
other conditions. 
You must therefore confirm that the overall machine or equipment complies with EC Directives.

• This is a Class A product (for industrial environments). In a residential environment, it may cause 
radio interference, in which case the user may be required to take appropriate measures.

Conformance to EC Directives

Applicable Directives

Concepts
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Observe the following precaution if you use NA-series PTs in Korea.

Class A Device (Broadcasting Communications Device for Business Use)

This device obtained EMC registration for office use (Class A), and it is intended to be used in places 
other than homes. Sellers and/or users need to take note of this.

Conformance to KC Standards
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Related Manuals

The following manuals are related to the NA-series PTs. Use these manuals for reference.

Manual name Cat. No. Models Applications Description

NA-series Program-
mable Terminal Hard-
ware User’s Manual

V117 NA5-W Learning the speci-
fications and set-
tings required to 
install an NA-series 
PT and connect 
peripheral devices.

Information is provided on NA-series 
PT specifications, part names, instal-
lation procedures, and procedures to 
connect an NA Unit to peripheral 
devices. 

Information is also provided on main-
tenance after operation and trouble-
shooting.

NA-series Program-
mable Terminal Soft-
ware User’s Manual

V118 NA5-W Learning about 
NA-series PT 
pages and object 
functions.

NA-series PT pages and object func-
tions are described.

NA-series Program-
mable Terminal 
Device Connection 
User’s Manual

V119 NA5-W Learning the speci-
fications required 
to connect devices 
to an NA-series 
PT.

Information is provided on connec-
tion procedures and setting proce-
dures to connect an NA-series PT to 
a Controller or other device.

NA-series Program-
mable Terminal 
Startup Guide

V120 NA5-W Learning in con-
crete terms infor-
mation required to 
install and start the 
operation of an 
NA-series PT.

The part names and installation pro-
cedures are described followed by 
page creation and transfer proce-
dures with the Sysmac Studio. Also 
operation, maintenance, and inspec-
tion procedures after the project is 
transferred are described. Sample 
screen captures are provided as 
examples.

NJ-series CPU Unit 
Hardware User’s 
Manual

W500 NJ501-

NJ301-

Learning the basic 
specifications of 
the NJ-series CPU 
Units, including 
introductory infor-
mation, designing, 
installation, and 
maintenance.

Mainly hardware 
information is pro-
vided.

An introduction to the entire 
NJ-series system is provided along 
with the following information on a 
Controller built with a CPU Unit.

• Features and system configuration

• Introduction

• Part names and functions

• General specifications

• Installation and wiring

• Inspection and maintenance

Use this manual together with the 
NJ-series CPU Unit Software User’s 
Manual (Cat. No. W501).
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NJ-series CPU Unit 
Software User´s 
Manual

W501 NJ501-

NJ301-

Learning how to 
program and set 
up an NJ-series 
CPU Unit.

Mainly software 
information is pro-
vided.

Provides the following information on 
a Controller built with an NJ-series 
CPU Unit.

• CPU Unit operation

• CPU Unit features

• Initial settings

• Programming based on IEC 
61131-3 language specifications

Use this manual together with the 
NJ-series CPU Unit Hardware 
User’s Manual (Cat. No. W500).

CJ Series Program-
mable Controllers 
Operation Manual

W393 CJ1H-CPUH-R

CJ1G/H-CPUH

CJ1G-CPUP

CJ1M-CPU

CJ1G-CPU

Learning the basic 
specifications of 
the CJ-series 
PLCs, including 
introductory infor-
mation, designing, 
installation, and 
maintenance.

The following information is provided 
on a CJ-series PLC.

• Introduction and features

• System configuration design

• Installation and wiring

• I/O memory allocation

• Troubleshooting

Use this manual together with the 
Programming Manual (Cat. No. 
W394).

CS/CJ/NSJ Series 
Programmable Con-
trollers Operation 
Manual

W394 CS1G/H-CPUH

CS1G/H-CPU-V1

CS1D-CPUH

CS1D-CPUS

CJ1H-CPUH-R

CJ1G/H-CPUH

CJ1G-CPUP

CJ1M-CPU

CJ1G-CPU

NSJ-(B)-G5D

NSJ-(B)-M3D

Learning about the 
functions of the 
CS/CJ-series and 
NSJ-series PLCs.

The following information is provided 
on a CS/CJ-series or NSJ-series 
PLC.

• Programming

• Master function

• File memory

• Other functions

Use this manual together with the 
Operation Manual (CS-series PLCs: 
W339, CJ-series PLCs: W393).

CS/CJ/NJ-series 
Instructions Refer-
ence Manual

W340 CS1□-CPU--

CJ1□-CPU--

CJ2H-CPU--

NSJ--

Learning detailed 
information on pro-
gramming instruc-
tions.

Instructions are described in detail.

When programming, use this manual 
together with the Operation Manual 
(CS-series PLCs: W339, CJ-series 
PLCs: W393) and the Programming 
Manual (W394).

CS/CJ Series Pro-
gramming Consoles 
Operation Manual

W341 CQM1H-PRO01

CQM1-PRO01

C200H-PRO27

+CS1W-KS001

Learning the oper-
ating procedures 
of the Program-
ming Consoles.

The operating procedures of the Pro-
gramming Consoles are described.

When programming, use this manual 
together with the Operation Manual 
(CS-series PLCs: W339, CJ-series 
PLCs: W393), the Programming 
Manual (W394), and the Instructions 
Reference Manual (W340).

Manual name Cat. No. Models Applications Description
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CS/CJ/NSJ Series 
Communications 
Commands Refer-
ence Manual

W342 CS1G/H-CPUH

CS1G/H-CPU-V1

CS1D-CPUH

CS1D-CPUS

CS1W-SCU-V1

CS1W-SCB-V1

CJ1G/H-CPUH

CJ1G-CPUP

CJ1M-CPU

CJ1G-CPU

CJ1W-SCU-V1

Learning detailed 
specifications on 
the communica-
tions instructions 
addressed to 
CS/CJ-series CPU 
Units and 
NSJ-series PLCs.

1) C-mode commands and 2) FINS 
commands are described in detail.

Refer to this manual for information 
on communications commands 
(C-mode commands and FINS com-
mands) addressed to CPU Units.

Note This manual describes com-
munications commands that 
are addressed to a CPU Unit. 
The communications path is 
not relevant. (The communi-
cations commands can be 
sent through the serial com-
munications port of the CPU 
Unit, the communications 
port of a Serial Communica-
tions Board/Unit, or a com-
munications port on another 
Communications Unit.)

CJ-series CJ2 CPU 
Unit Hardware User’s 
Manual

W472 CJ2H-CPU6-EIP

CJ2H-CPU6

CJ2M-CPU

Learning the hard-
ware specifica-
tions of CJ2 CPU 
Units.

The following information is provided 
on a CJ2 CPU Unit.

• Introduction and features

• Basic system configuration

• Part names and functions

• Installation and setting procedures

• Troubleshooting

Use this manual together with the 
Software User’s Manual (Cat. No. 
W473).

CJ-series CJ2 CPU 
Unit Software User’s 
Manual

W473 CJ2H-CPU6-EIP

CJ2H-CPU6

CJ2M-CPU

Learning the soft-
ware specifica-
tions of CJ2 CPU 
Units.

The following information is provided 
on a CJ2 CPU Unit.

• CPU Unit operation

• Internal memory

• Programming

• Settings

• Functions built into the CPU Unit

Use this manual together with the 
Hardware User’s Manual (Cat. No. 
W472).

Ethernet Units Oper-
ation Manual Con-
struction of Networks

W420 CS1W-ETN21

CJ1W-ETN21

Learning how to 
use an Ethernet 
Unit.

Information is provided on the Ether-
net Units.

Information is provided on the basic 
setup and FINS communications.

Refer to the Communications Com-
mands Reference Manual (Cat. No. 
W342) for details on FINS com-
mands that can be sent to 
CS/CJ-series CPU Units when using 
the FINS communications service.

Manual name Cat. No. Models Applications Description
23NA Series Programmable Terminal Software User’s Manual (V118)



   Related Manuals
Ethernet Units Oper-
ation Manual Con-
struction of 
Applications

W421 CS1W-ETN21

CJ1W-ETN21

Learning how to 
use an Ethernet 
Unit.

Information is provided on construct-
ing host applications, including func-
tions for sending/receiving mail, 
socket service, automatic clock 
adjustment, FTP server functions, 
and FINS communications.

CS/CJ-series Ether-
Net/IP™ Units Oper-
ation Manual

W465 CJ2H-CPU6-EIP

CJ2M-CPU3

CS1W-EIP21

CJ1W-EIP21

Learning how to 
use the built-in 
EtherNet/IP port of 
the CJ2 CPU 
Units.

Information is provided on the built-in 
EtherNet/IP port and EtherNet/IP 
Units.

Basic settings, tag data links, FINS 
communications, and other functions 
are described.

Sysmac Studio Ver-
sion 1 Operation 
Manual

W504 SYSMAC-SE2 Learning about the 
operating proce-
dures and func-
tions of the 
Sysmac Studio.

The operating procedures of the 
Sysmac Studio are described.

CX-Programmer 
Operation Manual

W446 CXONE-ALC-V4

CXONE-ALD-V4

Learning about the 
CX-Programmer 
except for informa-
tion on function 
blocks, ST pro-
gramming, and 
SFC programming.

The operating procedures of the 
CX-Programmer are described.

Manual name Cat. No. Models Applications Description
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Terminology

Term Description

HMI A general term for interface devices that indicates both hardware and software elements. In 
this manual, “HMI” refers to an OMRON Sysmac-brand product unless otherwise specified. 

PT The hardware elements of the HMI. 

NA Series The NA Series of Programmable Terminals and peripheral devices.

HMI Project A Sysmac Studio project for an HMI.

NA Unit An NA-series Programmable Terminal.

Download Transferring data from the Sysmac Studio to an HMI.

IAG collection When you provide IAGs, you provide them as IAG collections. IAGs are also imported as 
IAG collections. An IAG collection contains one or more IAGs.
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Revision History

A manual revision code appears as a suffix to the catalog number on the front and back covers of the 
manual.

Revision code Date Revised content

01 June 2014 Original production

Cat. No. V118-E1-01
Revision code
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1   Introduction to the NA-series Programmable Terminals
1-1 NA-series Programmable Terminals

The NA-series Programmable Terminals represent the next generation of HMIs for industrial applica-
tions. They display information on FA manufacturing sites and function as control interfaces while pro-
viding safety, reliability, and maintainability. They provide all of the functions of traditional programmable 
terminals with a clearer, easy-to-use interface.

OMRON offers the new Sysmac Series of control devices designed with unified communications speci-
fications and user interface specifications.

The NA-series Programmable Terminals are Sysmac devices that you can use together with the 
NJ-series Machine Automation Controllers and the Sysmac Studio Automation Software to achieve 
optimum functionality and ease of operation.

If you connect an NA-series Programmable Terminal to an NJ-series Controller, all you have to do to 
specify memory in the Controller is to specify the Controller variables for the objects on the Program-
mable Terminal screens. This allows you to create screens without being concerned with the memory 
map of the Controller.

 High-resolution Display Panels

High-resolution display panels are used to more clearly display large amounts of information than 
was possible with previous OMRON products.

 Two Ethernet Ports (Standard Feature)

You can use both Ethernet ports to separate the segment attached to control devices from the seg-
ment attached to maintenance devices. Access is possible from both segments at the same time.

You can connect the following devices.

• NJ-series Controllers

• PLCs

• Computers

• Sysmac Studio

1-1-1 Features

Hardware Features

NJ-series Controller

Ethernet

NA-series PTAutomation Software
Sysmac Studio Specifications with Only 

Variables from Objects on 
Screens

Programming with 
Variables to Eliminate 

Worrying about the 
Memory Map
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 Standard-feature SD Memory Card Slot

You can use an SD Memory Card inserted in the NA Unit to automatically transfer the project you 
created on the Sysmac Studio to the NA Unit, to update the system program in the NA Unit, or to 
save the log data from the NA Unit.

 Specifications with Variables for Superior Reusability

If you connect to an NJ-series Controller, all you have to do to specify memory in the Controller is to 
specify the Controller variables. This allows you to create objects that are not dependent on specific 
devices or memory maps. This in turn makes the objects much more reusable than they were with 
previous PTs.

 Program with Visual Basic

You can use Microsoft’s Visual Basic to program advanced functions that you cannot achieve with 
standard objects.

 A Wealth of Security Features

The many security features of the NA-series PTs include operation authority settings and execution 
restrictions with IDs.

 Use the Integrated Development Environment of Sysmac Studio Automation 
Software

You use the Sysmac Studio to create applications for the NA-series Programmable Terminals.

The Sysmac Studio provides an integrated development environment that covers not only the 
NA-series Programmable Terminal, but also the Controller and devices on EtherCAT as well.

You can use consistent procedures for all devices regardless of differences in the devices. The Sys-
mac Studio supports all phases of Controller application, from page creation and sequence design 
through debugging, simulations, commissioning, and changes during operation.

 A Wealth of Simulation Features

You can perform simulations using a virtual HMI on the Sysmac Studio. And you can also perform 
online debugging with a virtual NJ-series Controller.

Software Features
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1-2 How HMIs Operate

This section describes how the HMI operates.

An HMI consists of the following software.

• System Program

The system program is required to start the HMI and execute the runtime. For details, refer to 
NA-series Programmable Terminal Hardware User’s Manual (V117). 

• Runtime

The runtime is the middleware that executes the project. The runtime is started by the system pro-
gram and it manages execution of the project.

• Project

You use the Sysmac Studio to create your applications. The applications are executed on the run-
time.

An HMI project contains mainly the following data.

In addition, there is data that is shared by the entire project, such as user alarms, data logging, recipes, 
and resources.

One HMI screen is called a page. 

There are the following two types of pages.

You paste objects on the pages.

1-2-1 HMI Software Configuration

1-2-2 HMI Projects

1-2-3 Pages

Pages Pages consist of 
objects.

Project Global variables HMI variables

Global events Events that are shared 
by the entire project

Subroutines You can start subroutines 
when events occur.

You can specify variables, 
and the actions for events.

Page type Size

Main Maximum screen size for each model

Popup Smaller than the maximum screen 
size for each model

Page
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The objects that you paste on HMI pages consist of the following three elements.

1-2-4 Objects

Element

Properties These are static properties.
Example: Names and other general properties, colors, 

positioning, and other display properties, and 
assigned condition expressions or variables

You can specify events and the actions to perform when the 
events occur.
Example: You can specify subroutines to execute, e.g., 

when a function key is pressed or a value 
changes.

Operating properties for condition expressions
Example: Operating specifications, such as flashing, 

enabling/disabling operation, size/coordinate 
changes, and displaying/hiding.

Animations

Events and 
Actions

Object
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You use HMI global variables to specify memory in a Controller or PLC.

You assign HMI global variables to connected device variables in advance to map them.

1) Variables for connected devices are registered to device variables in the HMI project with one of the 
following methods.

a) Variables for connected devices that are registered in the same project are registered automati-
cally.

b) You can copy and paste variables from another project using the clipboard.

c) You can import variables from the external connected device.

2) Devices variables are assigned to HMI global variables.

3) The assigned HMI global variables are specified in the properties of the objects.

4) Then, you transfer the project that you created to the HMI.

Refer to 4-1 Registering Variables on page 4-2 for the details on HMI variables.

1-2-5 Memory Specifications for Connected Devices

Overview

Sysmac Studio 
project

Global variables

Sysmac Studio

a) Automatic registration

Object

Pages

Global variables

Device variables

HMI project

P

1)

Device registered in the project
(NJ-series Controller)

HMIc) Importing

Physical NJ-series 
Controller or other device

2) Assigned.

4) Transferred.

Different project, i.e., 
in Sysmac Studio

Global variables

HMI settings

b) Pasted from 
clipboard.

3) Variables 
specified in 
properties

Controller
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Events are triggers that activate actions.*1

*1. Actions are various operations that can be directly assigned to events.

Events occur when the common page status or object status meets certain conditions.

Events are classified into three groups as shown below.

1-2-6 Events

Group Description

Global events Events that occur for shared project status.

Events that occur for specific page or object status.Page and object eventsEvents

Events that occur for user alarm status.User alarm events
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You can execute user-created subroutines in the HMI based on the following three types of conditions.

• When global events occur

• When events occur on pages or for objects

• When user alarm events occur

There are two types of subroutines that you can create.

• Global Subroutines

You create these subroutines under the global subroutine item of the HMI project.

• Page Subroutines

You create these subroutines with the page code editor.

You can use Visual Basic to write both the global subroutines and the page subroutines.

• You can call a global subroutine by executing the CallSubroutine action when a global event occurs.

1-2-7 Subroutines

• Global events (i.e., events shared by all pages)

• Object event

[0]: Event: F1 Key Click
Action: CallSubroutine

• User Alarm Event

Global 
subroutine

[1]: Event: Interval
Action: IncreaseVariableEvents

Called.

Executed.

Coded in Visual Basic

Object action

Action: CallSubroutine

Page

Object

Called.

Sysmac Studio project

Press Page 
subroutine

Called.

[0]: Event: Raised
Action: CallSubroutine

[1]: Event: Acknowledged
Action: IncreaseVariable
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• You can call a global subroutine or page subroutine by executing the CallSubroutine action when an 
event occurs on the page or for an object.

• You can call a global subroutine by executing the CallSubroutine action when a user alarm event 
occurs.

You can also call a global subroutine from another global subroutine or a page subroutine.

In addition to global events, the following functions are shared by the entire HMI project.

Alarms notify the user when certain conditions are met in the HMI.

The following alarms are supported.

• User alarms

You can log data to store the changes in the values of specified variables over time.

You can display the saved data with Trend Graph objects. You can also save this data to external files.

A recipe is used to write data (numeric data or text strings) that was set in advance in the project to all 
of the specified variables as a group or to read all of the specified variables as a group.

You can manipulate the registered recipe data with Recipe Viewer objects.

You can manage resources, such as the text strings, movies, still images, and documents that are dis-
played for objects and alarms on pages.

The following data is retained when the power supply is turned OFF. 

With No Battery or Low Battery Voltage

• Project data

• Log data that is not written to the SD Memory Card

• User alarm history

• Values of variables with Retain attribute

• Calibration information for touch panel

With Good Battery (in addition to the above)

• Clock information

1-2-8 Functions Shared by the Entire HMI Project

Alarms

Data Logging

Recipes

Resources

1-2-9 Data That Retained When Power Is Turned OFF
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1   Introduction to the NA-series Programmable Terminals
1-3 Operating Procedure for HMIs

This section gives the operating procedure for an HMI and then describes it in more detail.

The overall procedure to use an HMI is given below.

STEP1 System Configuration and Project Design

Design the system configurations and project.

STEP2 Software Settings (Configurations and Setup) and Creating the HMI Application

Create the system configurations that you designed in step 1 on the Sysmac Studio. Also create 
the project (pages, variables, subroutines, etc.), build the project, and debug it with simulation 
and other functions.

STEP3 Mounting and Wiring

Mount the HMI.

Connect the connected device and computer (Sysmac Studio) to the HMI.

STEP4 Confirming Operation and Starting Actual System Operation

Download the project from the Sysmac Studio.

Make the settings on the System Menu, check operation on the physical devices, and start 
operation.

1-3-1 Overall Procedure

STEP 1-1 Designing the System Configurations

STEP 1-2 Designing the Project (Pages, Variables, Subroutines, etc.)

Determining the Connected Device Variables 
and Mapping HMI Variables to Them (We rec-
ommend this as the basic procedure.)

Setting HMI Variables First and Then Mapping 
Them to Connected Device Variables

STEP 2-1 Starting the Sysmac Studio and Creating 
a Project

STEP 2-1 Starting the Sysmac Studio and Creating 
a Project

STEP 2-2 Software Settings (Configurations and 
Setup)

STEP 2-2 Creating the HMI Application

STEP 2-3 Creating the HMI Application STEP 2-3 Software Settings (Configurations and 
Setup)

STEP 2-4 Building the HMI STEP 2-4 Building the HMI

STEP 2-5 Offline Debugging STEP 2-5 Offline Debugging
1 - 10 NA Series Programmable Terminal Software User’s Manual (V118)
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STEP1 System Configuration and Project Design

STEP2 Software Settings (Configurations and Setup) and Creating the HMI Application

1-3-2 Procedure Details

Step Description Reference

STEP 1-1 
Designing the 
System Configu-
rations

• Connect an HMI to the external 
device.

• Connect an HMI to the Sysmac 
Studio.

Section 2 Configuration Units in NA Series 
Programmable Terminal Hardware User’s 
Manual (V117)

NA-series Programmable Terminal Device 
Connection User’s Manual (V119)

STEP 1-2 
Designing the 
Project (Pages, 
Variables, Sub-
routines, Etc.)

Design the project as given below. NA Series Programmable Terminal Software 
User's Manual (V118)

1) Designing the 
Pages and Sub-
routines

• Design the contents to display on 
the pages (the pages and objects 
to use).

• Design the execution methods 
and contents of the subroutines.

2) Designing 
Items Shared by 
All Pages

• Design the global events.

• Design the alarms, recipes, data 
logging, and other functions.

3) Variable Design

• HMI external variable design: 
Design the mappings between the 
connected device variables and 
the HMI global variables.

• Design the HMI internal variables 
and subroutine variables.

• Define the attributes of the above 
variables, such as the Data Type, 
Name, and Retain attributes.

Step Description
Sysmac Studio oper-
ations

Reference

STEP 2-1 
Starting the Sys-
mac Studio and 
Creating a Project

1. Start the Sysmac 
Studio and create a 
project.

2. Insert the HMI.

Press the New Project 
Button. 
Use HMI on the Insert 
Menu.

Sysmac Studio Version 1 Opera-
tion Manual (W504)

Section 2 Basic Sysmac Studio 
Operations
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1   Introduction to the NA-series Programmable Terminals
 Determining the Connected Device Variables and Mapping HMI Variables to 
Them

We recommend this procedure as the basic procedure.

• Connecting to a Connected Device Registered in the Current Project

• Connecting to a Connected Device Not Registered in the Current Project

STEP 2-2 
Software Set-
tings (Configura-
tions and Setup)

Make the initial software settings 
on the Sysmac Studio.

Use Configurations 
and Setup in the Mul-
tiview Explorer of the 
Sysmac Studio.

Section 3 HMI Config-
uration and Setup

• Mapping Vari-
ables

• Assign global variables to con-
nected device variables (map-
ping variables).

Map the variables 
under Configura-
tions and Setup − 
Variable Mapping.

3-3 Mapping Vari-
ables on page 3-7

• HMI Settings

• Set the parameters related to 
the HMI. 
Startup Page, Brightness Set-
tings, IP Address, FTP Settings, 
NTP Settings, FINS Settings, 
VNC Settings, etc.

Make the settings 
under Configura-
tions and Setup − 
HMI Settings.

3-4 HMI Settings on 
page 3-10

• Security Set-
tings and Lan-
guage Settings

• Set the operation rights to the 
HMI and the language to display 
on the HMI.

Make the settings 
under Configura-
tions and Setup − 
Security Settings and 
Configurations and 
Setup − Language 
Settings.

3-5 Security Settings 
on page 3-17

3-6 Language Set-
tings on page 3-18

STEP 2-2 
Software Set-
tings (Configura-
tions and Setup)

Make the initial software settings 
on the Sysmac Studio.

Use Configurations 
and Setup in the 
Multiview Explorer of 
the Sysmac Studio.

Section 3 HMI Config-
uration and Setup

• Device Settings

• Register the external connected 
devices.

Add the connected 
device under Configu-
rations and Setup − 
Device References.

3-2 Device References 
on page 3-3

• You can do either of the follow-
ing.

a) Importing Variables from the 
Actual Connected Device: 
Place the Sysmac Studio 
online with the connected 
device and import the vari-
ables from the connected 
device.

Set up communica-
tions and import the 
variables.

b) Importing Variables from 
Another Project: Copy the 
variable table in the other 
project and paste it in the 
variable table for the con-
nected device to import the 
variables.

Copy the variable table 
from another project 
using the clipboard.
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• Mapping Vari-
ables

Assign global variables to con-
nected device variables (mapping 
variables).

Map the variables 
under Configura-
tions and Setup − 
Variable Mapping.

Section 3 HMI Config-
uration and Setup and 
3-3 Mapping Vari-
ables on page 3-7

• HMI Settings

• Set the parameters related to 
the HMI. 
Startup Page, Brightness Set-
tings, IP Address, FTP Settings, 
NTP Settings, FINS Settings, 
VNC Settings, etc.

Make the settings 
under Configura-
tions and Setup − 
HMI Settings.

3-4 HMI Settings on 
page 3-10

• Security Set-
tings and Lan-
guage Settings

• Set the operation rights to the 
HMI and the language to display 
on the HMI.

Make the settings 
under Configura-
tions and Setup − 
Security Settings and 
Configurations and 
Setup − Language 
Settings.

3-5 Security Settings 
on page 3-17

3-6 Language Set-
tings on page 3-18

STEP 2-3 
Creating the HMI 
Application

Create the application (pages, 
variables, subroutines, etc.) with 
the Sysmac Studio.

Use HMI in the Multiv-
iew Explorer of the 
Sysmac Studio.

Section 4 Creating the 
HMI Application

1) Registering 
Variables

• Register the variables in the HMI 
global variable table with the 
Sysmac Studio.

Note: Variables that were mapped 
in step 2-2 are automatically regis-
tered in the HMI global variables 
table.

Use the editor for HMI 
− Data − Global Vari-
ables

4-1 Registering Vari-
ables on page 4-2

2) Creating Pages
• Paste the objects on each page 

and set the object properties 
and other settings. 

Use the editor for HMI 
− Pages.

4-2 Creating Pages on 
page 4-11

3) Creating Sub-
routines

• Create the subroutines.

You can create the following.

• Global subroutines

• Page subroutines

Subroutines shared by 
the entire project: 
Select HMI − Global 
Subroutine. 
Page subroutines: Use 
HMI − Pages | Page 
Name and select View 
Code from the individ-
ual pages.

4-4 Subroutines on 
page 4-27

4) Settings 
Shared by All 
Pages

• Make the settings that are 
shared by the project: alarms, 
recipes, data logging, global 
events, etc.

Use HMI − User 
Alarms, HMI − Reci-
pes, etc.

4-3 Setting Common 
Object Functions on 
page 4-18

STEP 2-4 
Building the HMI

• Convert the HMI project into a 
form that the HMI can execute.

Use Build HMI on the 
Project Menu.

4-6 Building on page 
4-33

STEP 2-5 
Offline Debug-
ging

• Check the operation of the 
pages on the Simulator (a virtual 
HMI).

Use Start NA Simula-
tion or Run with Con-
troller Simulator on 
the Simulation Menu.

Section 7 Debugging
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1   Introduction to the NA-series Programmable Terminals
 Setting HMI Variables First and Then Mapping Them to Connected Device 
Variables

• Connecting to a Connected Device Registered in the Current Project

STEP 2-2 
Creating the HMI 
Application

Create the application (pages, 
variables, subroutines, etc.) 
with the Sysmac Studio.

Use HMI in the Multiview 
Explorer of the Sysmac Stu-
dio.

Section 4 Creating the 
HMI Application

1) Registering 
Variables

Register the variables in the 
HMI global variable table with 
the Sysmac Studio.

HMI − Data − Global Variables 
Table

4-1 Registering Vari-
ables on page 4-2

2) Creating Pages
Paste the objects on each 
page and set the object prop-
erties.

Use the editor for HMI − 
Pages.

4-2 Creating Pages on 
page 4-11

3) Creating Sub-
routines

Create the subroutines.

You can create the following.

• Global subroutines

• Page subroutines

Subroutines shared by the 
entire project: Select HMI − 
Add Global Subroutine. 
Page subroutines: Use HMI − 
Pages and select View Code 
from the individual pages.

4-4 Subroutines on 
page 4-27

4) Settings 
Shared by All 
Pages

Make the settings that are 
shared by the project: alarms, 
recipes, data logging, global 
events, etc.

Use HMI − User Alarms, HMI 
− Recipes, etc.

4-3 Setting Common 
Object Functions on 
page 4-18

STEP 2-3 
Software Set-
tings (Configura-
tions and Setup)

Make the initial software settings 
on the Sysmac Studio.

Use Configurations 
and Setup in the Mul-
tiview Explorer of the 
Sysmac Studio.

Section 3 HMI Config-
uration and Setup

• Mapping Vari-
ables

• Assign global variables to con-
nected device variables (map-
ping variables).

Map the variables 
under Configura-
tions and Setup − 
Variable Mapping.

3-3 Mapping Vari-
ables on page 3-7

• HMI Settings

• Set the parameters related to 
the HMI. 
Startup Page, Brightness Set-
tings, IP Address, FTP Settings, 
NTP Settings, FINS Settings, 
VNC Settings, etc.

Make the settings 
under Configura-
tions and Setup − 
HMI Settings.

3-4 HMI Settings on 
page 3-10

• Security Set-
tings and Lan-
guage Settings

• Set the operation rights to the 
HMI and the language to display 
on the HMI.

Make the settings 
under Configura-
tions and Setup − 
Security Settings and 
Configurations and 
Setup − Language 
Settings.

3-5 Security Settings 
on page 3-17

3-6 Language Set-
tings on page 3-18
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• Connecting to a Connected Device Not Registered in the Current Project

STEP2-3 
Software Set-
tings (Configura-
tions and Setup)

Make the initial software settings 
on the Sysmac Studio.

Use Configurations 
and Setup in the Mul-
tiview Explorer of the 
Sysmac Studio.

Section 3 HMI Config-
uration and Setup

• Connected 
Device Settings

• Register the external connected 
devices.

Add the connected 
device under Configu-
rations and Setup − 
Device References.

3-2 Device References 
on page 3-3

• You can do either of the follow-
ing.

a) Importing Variables from the 
Unit Connected Device: 
Place the Sysmac Studio 
online with the connected 
device and import the vari-
ables from the connected 
device.

Set up communica-
tions and import the 
variables.

3-2-2 Connected 
Devices in the Current 
Project on page 3-3

b) Importing Variables from 
Another Project: Copy the 
variable table in the other 
project and paste it in the 
device variable table.

Copy the variable table 
from another project 
using the clipboard.

• Assign global variables to con-
nected device variables (map-
ping variables).

Map the variables 
under Configura-
tions and Setup − 
Variable Mapping.

3-3 Mapping Vari-
ables on page 3-7

• HMI Settings

• Set the parameters related to 
the HMI. 
Startup Page, Brightness Set-
tings, IP Address, FTP Settings, 
NTP Settings, FINS Settings, 
VNC Settings, etc.

Make the settings 
under Configura-
tions and Setup − 
HMI Settings.

3-4 HMI Settings on 
page 3-10

• Security Set-
tings and Lan-
guage Settings

• Set the operation rights to the 
HMI and the language to display 
on the HMI.

Make the settings 
under Configura-
tions and Setup − 
Security Settings and 
Configurations and 
Setup − Language 
Settings.

3-5 Security Settings 
on page 3-17

3-6 Language Set-
tings on page 3-18

STEP 2-4 
Building the HMI

• Convert the HMI project into a 
form that the HMI can execute.

Use Build HMI on the 
Project Menu.

4-6 Building on page 
4-33

STEP2-5 
Offline Debug-
ging

• Check the operation of the 
pages on the Simulator (a virtual 
HMI).

Use Start NA Simula-
tion or Run with Con-
troller Simulator on 
the Simulation Menu.

Section 7 Debugging
1 - 15NA Series Programmable Terminal Software User’s Manual (V118)



1   Introduction to the NA-series Programmable Terminals
STEP3 Mounting and Wiring

STEP4 Confirming Operation and Starting Actual System Operation

Step Description Reference

1) Mounting
• Mount the HMI to the panel.

• Wire Power Supply.

3-3 Installing NA Units in NA Series Pro-
grammable Terminal Hardware User's Man-
ual (V117)

2) Wiring the 
Ethernet Cable to 
the Connected 
Device

• Wire the Ethernet cables. 3-4 Wiring Method in NA Series Program-
mable Terminal Hardware User's Manual 
(V117)

NA-series Programmable Terminal Device 
Connection User’s Manual (V119)

3) Connecting the 
Computer (Sys-
mac Studio)

• Wire the USB cable.

or

• Wire the Ethernet cable.

2-4 Support Software in NA Series Program-
mable Terminal Hardware User's Manual 
(V117)

Step Description
Sysmac Studio 
operations

Reference

1) Online Connec-
tion to Sysmac 
Studio and Proj-
ect Download

• Turn ON the power supply to the 
HMI and place the Sysmac Stu-
dio online. Then, download the 
project.*1

*1.Use the Synchronize operation 
of the Sysmac Studio to 
download the project.

Use Communica-
tions Setup on the 
HMI Menu.

Use Synchroniza-
tion on the HMI 
Menu.

Section 6 Connecting 
to the HMI and Section 
8 Synchronizing Proj-
ects

2) Operation 
Check on NA Unit

• Integrate the NA Unit into the 
actual system, manipulate the 
project that you created and 
confirm the following: that cor-
rect values are written to the 
connected device, that the 
pages change correctly, and that 
values set at the connected 
device are updated.

--- Section 7 Debugging

3) Actual System 
Operation

• Start actual operation. --- ---
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2   Basic Sysmac Studio Operations
2-1 Parts of the Sysmac Studio Window

This section gives the names and functions of the parts of the Sysmac Studio Window.

This manual describes only functions that apply when an HMI is selected for the device. For information 
on Sysmac Studio functions not described in this manual, refer to the Sysmac Studio Version 1 Opera-
tion Manual (Cat. No. W504).

Precautions for Correct Use

When you use the Sysmac Studio, use the standard Windows desktop theme. If you do not use 
the standard Windows desktop theme, part of the display may not be correct.

The functions of these parts are described starting on the next page.

2-1-1 Application Window

Number Name

(a) Multiview Explorer

(b) Edit Pane

(c) Toolbox

Configurations and Setup Header

HMI Header

Menu bar Toolbar Layered headers
Tab

(a) (b) (c)
2 - 2 NA Series Programmable Terminal Software User’s Manual (V118)
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Multiview Explorer (a)

• This pane is your access point for all Sysmac Studio data. 
When an HMI is selected, it is divided into a Configurations 
and Setup Layer and an HMI Layer.

• You can also display the Page Explorer to display lists of 
objects on pages or the Code Explorer to display lists of 
subroutines.
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2   Basic Sysmac Studio Operations
 Layers and Items in the Multiview Explorer

Precautions for Correct Use

You cannot download the data to the HMI if an error icon is displayed.

 Page Explorer

 Code Explorer

The basic Sysmac Studio operations on the Edit Pane generally apply to HMIs. If an HMI is selected, 
you can edit pages and set up the HMI.

Configurations and Setup HMI

Device References Page

Variable Mapping Pages

HMI Settings User Alarms

Security Settings Groups

Language Settings Data Logging

DataSet

Recipes

Data

Global Variables

Global Events

Global Subroutines

Subroutine Groups

Resources

IAG Resources

The Page Explorer displays a list of objects on a page. If you click an object in the 
Page Explorer, the object will be selected on the Edit Pane.

To change the attributes for grouped objects or for individual objects in IAGs, select 
the individual objects on the Page Explorer.

The Code Explorer displays the subroutines in the project. You can double-click a 
subroutine to edit it.

Edit Pane (b)
2 - 4 NA Series Programmable Terminal Software User’s Manual (V118)



2   Basic Sysmac Studio Operations
2-1  P

arts o
f th

e S
ysm

ac S
tu

d
io

 W
in

d
o

w

2

2-1-1  A
pp

lication W
indow
Toolbox (c)

• The Toolbox shows the objects that you can use to edit the page that is displayed in 
the Edit Pane.

You can also display the Properties Window, Animations Window, and Events and 
Actions Window to make the settings of the objects.
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2   Basic Sysmac Studio Operations
2-2 Menu Command Structure

The menu commands that are displayed when an HMI is selected as the device are listed below.

Menu Submenu/command

File Close

―

Save

Save As

Save As New Number

Import

Export

Exit

Edit Undo

―

Redo

Cut

Copy

Paste

Delete

Select All

Search and Replace

View Multiview Explorer

―

Toolbox

Output Tab Page

Watch Tab Page

Build Tab Page

Search and Replace Results Tab Page

Page Explorer

Code Explorer

Properties

Animations

Events and Actions

Zoom Zoom In

Zoom Out

Zoom to Fit

Zoom Reset

Reset Window Layout ―

Insert Controller NJ301

NJ501

HMI NA5

Measurement Sensor ZW

Vision Sensor FQ-M

FH

External Device

―

Page

Page Group

User Alarm Group

Data Set

Recipe

Global Subroutine Group

Project Build HMI

―Abort Build

IAG Collections Manager
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HMI Communications Setup

―

Change Device

Online

Offline

Synchronization

Transfer to Media Device

HMI Clock

Update HMI Name

Security HMI Write Protection

Clear All Memory
―

Reset HMI Device

Simulation Start NA Simulation

―

Stop NA Simulation

Step Execution

Step In

Step Out

Continue

Set/Clear Breakpoint

Clear All Breakpoints

Run with Controller Simulator

Tools Option ―

Help Help Contents

―
Keyboard Mapping Reference

Online Registration

About Sysmac Studio

Menu Submenu/command
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2   Basic Sysmac Studio Operations
2-3 Basic Editing Operations

This section describes differences in basic Sysmac Studio operation when an HMI is selected as the 
device.

There are some differences in the standard operation of the Sysmac Studio when an HMI is selected as 
the device. This section describes those differences.

 Entering Variable Names and Data Types

• Entering variable names, e.g., when setting properties

• Entering data types in variable tables

Example: When you enter a variable name as a property, the variable names that you can enter are 
displayed in a list.

Entry Assistance
2 - 8 NA Series Programmable Terminal Software User’s Manual (V118)



2   Basic Sysmac Studio Operations
2

-3  B
as

ic E
d

itin
g

 O
p

era
tio

n
s

2

 Entering Text in the Code Editor

• When you enter text in the Code Editor, the cursor moves to the first item in the list that starts with 
the character that you entered.

• When you press the Tab Key after entering the first part of the keyword (“in” in this example), the 
rest of the keyword is automatically entered.
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2   Basic Sysmac Studio Operations
2-4 Sysmac Studio Settings and Opera-
tions

This section lists the operations of the Sysmac Studio that can be used only when an HMI is selected.

2-4-1 Setting Parameters

Item Description Reference

HMI Settings You can make settings for an HMI. Section 3 HMI Configuration 
and Setup

Device References If you connect an HMI to a device (e.g., Control-
ler or PLC) that is not registered in the current 
HMI project, the connected external device will 
be added.

3-2 Device References on 
page 3-3

Internal Projects Controllers registered in the project are dis-
played.

External Device You can set up communications and import vari-
ables for connected devices that have been 
added.

Variable Mapping You can associate variables in the connected 
devices with variables in the HMI.

3-3 Mapping Variables on 
page 3-7

2-4-2 Programming

Item Description Reference

Toolbox The Toolbox displays a list of the objects that 
you can use.

You can search for the required objects and 
drag them to the Page Editor to position the 
objects.

Section 5 Objects

Properties You can set the static attributes of the pages 
and objects.

Animations You can set the operations for object condition 
expressions.

Events and Actions You can set the actions to perform when events 
occur.

Page Explorer The Page Explorer displays a list of objects on a 
page. You can select objects or change the 
order of the display.

Code Explorer The Code Explorer displays lists of subroutines 
in the project. You can double-click a subroutine 
to edit it.

Page Editor You can position objects and create pages. You 
can also use the Page Editor to make settings 
for objects.

4-2 Creating Pages on page 
4-11

Code Editor You can use Visual Basic to create subroutines. 4-4 Subroutines on page 4-27
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Item Description Reference

Search and Replace You can search and replace strings in subrou-
tine data.

4-5 Search and Replace on 
page 4-32

Build Build HMI Convert the project into a form that the HMI can 
execute.

4-6 Building on page 4-33

Abort Build You can abort a build operation.

2-4-3 Library Functions

Item Description Reference

Toolbox You can register objects that you have created 
and then reuse them.

Section 9 Reusing Objects

IAG You can output an IAG that you created in an 
IAG project as an IAG collection, to use it in 
another project.

2-4-4 Operations for Debugging

Item Description Reference

Monitoring You can monitor variables during project execu-
tion.

You can monitor the present values of HMI 
global variables. You use the Watch Tab Page 
for monitoring.

Section 7 Debugging

Changing the Present Values 
of Variables

You can change the present values of global 
variables and system-defined variables.

You can do this on a Watch Tab Page.

Section 7 Debugging

Controlling Execution with 
Breakpoints and Step Execu-
tion

You can control simulation execution to monitor 
the program or to check operation. 
Step execution and pausing are also possible.

Section 7 Debugging

2-4-5 Communications

Item Description Reference

Going Online with an HMI You can place the computer online with an HMI 
to synchronize the project.

Section 6 Connecting to the 
HMI

2-4-6 Security Measures

Item Description Reference

Prevention of 
Incorrect Con-
nections

Confirming HMI 
device Names and 
Serial IDs

If the device name or the serial ID is different 
between the project and the HMI when an 
online connection is established, a confirmation 
dialog box is displayed.

3-5 Security Settings 
on page 3-17

Preventing Incor-
rect Operation

Operation Author-
ity Verification

You can use operation authorities to restrict the 
ability to perform operations or display data.

Prevention of the 
Theft of Assets

Password Protec-
tion for Project 
Files

You can set password protection for project files 
to protect your assets.
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2-4-7 Online Help

Item Description Reference

Sysmac Studio Help System You can access Sysmac Studio operating pro-
cedures.

Keyboard Mapping Reference You can display a list of convenient shortcut 
keys that you can use on the Sysmac Studio.
2 - 12 NA Series Programmable Terminal Software User’s Manual (V118)



2   Basic Sysmac Studio Operations
2-5

  B
asic O

p
eratio

n
s fo

r H
M

I P
ro

jects

2

2-5-1  C
reating a P

roject F
ile from

 th
e P

roject W
indow
2-5 Basic Operations for HMI Projects

This section describes how to create and save projects and perform other basic operations to use 
HMIs.

Use the following procedure to create a project file from the Project Window.

1 Click the New Project Button in the Project Window.

The Project Properties Dialog Box is displayed. The following table gives the functions of the 
buttons.

2 Enter the project name, author, and comment in the Project Properties Dialog Box, select HMI 
from the device category, and then click the Create Button. (Only the project name is required.)

You can change the properties later. Refer to the Sysmac Studio Version 1 Operation Manual 
(Cat. No. W504).

A project file is created and the following window is displayed.

2-5-1 Creating a Project File from the Project Window

Menu command Description

New Project Button Creates a project file.

Open Project Button Opens an existing project file.

Project Window
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A project file is created with the specified device already inserted.

Right-click the Controller Icon and select Add Device from the menu.

Or, select the device directly from the Insert Menu.

Example: HMI - NA5: The Add Device Dialog Box is displayed.

Select the device and then click the OK Button. The device is added to the project.

2-5-2 Adding an HMI to an Existing Project
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To change the target device, select a device from the list.

Right-click the HMI Icon and select Change Device from the menu. Or, select Change Device from the 
HMI Menu.

The Change Device Dialog Box is displayed.

Select the device and then click the OK Button. The device is changed.

Precautions for Correct Use

• If you change the device, the settings for functions that are not supported by the new model 
will be lost.

• If you change to a model that has a different display size, the objects will be enlarged or 
reduced according to the new display size. However, elements other than objects, such as 
font sizes, will not change.

Set the version when you create a new HMI project or when you add an HMI to an existing project.

You can set the version to the runtime version of the HMI that you are using or to any earlier runtime 
version. You can program and make settings within the ranges that are supported for the runtime ver-
sion that you set for the HMI. If you attempt to use functions that are not supported by the runtime ver-
sion that you set, you will not be able to use them or errors will occur.

2-5-3 Changing Devices

HMI Versions
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3-1 Outline of Configurations and Setup

This section describes how to set up HMIs and connected devices, such as Controllers and PLCs. The 
following items are provided in the HMI Configurations and Setup.

Device references must be set only to connect to external devices that are not registered in the current 
project. They are not necessary to connect to a Controller that is registered in the current project.

The following figure shows the relationship between connected device references and variable map-
ping. 
The HMI global variables are mapped to the connected device variables.

To access variables in the connected devices from an HMI, you must map the variables.

Item Description

Device References You can set up connected devices and import variables.

Variable Mapping You can assign HMI variables to the variables in the connected devices.

HMI Settings These are the parameters related to the HMI.

Security Settings You can set up restrictions to operations on HMIs.

Language Settings You can make settings for multi-language projects.

3-1-1 Connected Device Registration and Variable Mapping

(A) Connected device variables are a) automatically imported from the same project or b) copied from 
another project or manually imported from an external device.

(B) The connected device variables are automatically registered in the variable mappings.

(C) The HMI global variables are mapped to the connected device variables.

(D) The mapped HMI global variables are automatically registered in the global variable table of the HMI.

(E) You specify HMI global variables in the object properties.

■

Boolean 
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Behaviour  
Expression Controller0_aaa

(D)

(C)

(B)

■

aaa
Integer 

Position Port
aaa
bbb

Boolean
Integer

Controller0
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Page 1
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Object Properties

(E) Selectable
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Mapping

Automatic registration

Selectable
Automatic registration

Device in 
the project

Variables automatically imported from Controllers in the project

Importing connected 
device variables

Variables copied through the clipboard from other 
projects or variables imported by accessing the 
physical device (PLC or Controller)

External device
Data typeVariable name

Global variables of connected devices

Connected Device References

Data type Variable name

HMI Global Variable Table

Data typeVariable name
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3-2 Device References

This section describes how to set up HMIs and connected devices, such as Controllers and PLCs.

Different operations are used to connect to Controllers that are registered and Controllers that are not 
registered in the current project.

• Controllers that are already registered in the current project are automatically registered in the HMI 
project as internal connected devices.

• To connect to a device that is not registered in the current HMI project, you must register the device 
as an external connected device.

Controllers that are registered in the current project are displayed as connected devices. Use the fol-
lowing procedure to display the device settings if you need to check them.

1 Click Device References under Configurations and Setup in the Multiview Explorer.

2 The Controllers that are registered in the current project are displayed under Internal Projects.

3 Double-click the project to display the following Device Configuration Tab Page.

3-2-1 Types of Connected Devices

3-2-2 Connected Devices in the Current Project
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To connect the HMI to a device that is not registered in the current HMI project, you must register the 
device as an external connected device. The procedures to register and set up external connected 
devices are given below.

This section describes how to register and set up external connected devices.

1 Right-click Device References under Configurations and Setup in the Multiview Explorer.

2 Select Add - ExternalDevice. The device is added as ExternalDevice, where  is a serial 
number starting from 0.

3 Double-click the new ExternalDevice.

3-2-3 Registering External Connected Devices

Registering and Setting Up External Connected Devices
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4 Select the vendor of the required device in the Device Vendor Box under Device Configura-
tion. The device series of the selected vendor is displayed. Make the selections for the required 
device. The device communications drivers of the vendor selected for the device series are dis-
played. Select the communications driver for the required device.

5 Make the required settings in the Communications Configuration Area. Refer to the NA-series 
Programmable Terminal Device Connection User’s Manual (Cat. No. V119) for details.
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To connect the HMI to a device that is not registered in the current HMI project, you must import the 
variables from the external connected device.

There are two ways to import external connected device variables.

• Importing device variables online from the actual external connected device

• Copying variables from the variable table in another project

 Importing Device Variables Online from the Actual External Connected 
Device

Click the Import Variables Button. The variables are imported from the external connected device.

Refer to the NA-series Programmable Terminal Device Connection User’s Manual (Cat. No. V119) 
for details.

 Copying Variables from the Variable Table in Another Project

You can use the clipboard to copy the required variables from the Support Software for the con-
nected device and paste them in the device variables table for the external connected device. How-
ever, you cannot copy connected device variables if they are structure variables.

Refer to the NA-series Programmable Terminal Device Connection User’s Manual (Cat. No. V119) 
for details.

If you change the variables on a device, update the device variables in the HMI project as required.

There are two ways to update device variables.

• Updating device variables online from the actual external connected device

• Copying variables from the variable table in another project

 Updating Device Variables Online from the Actual External Connected Device

Click the Update Variables Button. The differences between the variables on the external con-
nected device and the device variables in the HMI project are displayed. Select the variables to 
update.

 Copying Variables from the Variable Table in Another Project

You can use the clipboard to copy the required variables from the Support Software for the con-
nected device and paste them in the device variables table for the external connected device.

Importing External Connected Device Variables

Updating Device Variables
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3-3 Mapping Variables

This section describes the settings required to access variables in connected devices through HMI 
global variables.

Mapping variables refers to assigning variables in devices connected to the HMI (called device vari-
ables) to global variables in the HMI. Device variables are used on the HMI by assigning them to HMI 
global variables.

Therefore, mapping variables is required. Not accessing device variables directly allows you to reuse 
projects simply by changing the variable mappings.

Global variables that are assigned to device variables are called external variables.

1 Double-click Variable Mapping under Configurations and Setup.

The Variable Mapping Tab Page is displayed.

3-3-1 Mapping Variables

3-3-2 Opening the Variable Mapping Tab Page and Tab Page Parts

Parts of the Window

No Item Description

1 Position Displays the IP addresses of the connected devices.

2 Port Displays the connected devices and device variables in a tree structure.

3 Data Type The data types of the device variables are displayed.
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To map variables, you can either create new global variables and assign them or you can assign previ-
ously created global variables.

To increase the reusability of the project, create the global variables first and then assign them.

However, if a device variable is a structure, you must create a new external variable during variable 
mapping.

You can create a new global variable and assign it to a device variable.

When you create an external variable, you can either have the name generated automatically or you 
can create it manually.

 Automatically Creating New Variable Names

Use the following procedure.

1 Select one or more device variables in the variable mappings, right-click, and select Create 
Device Variable from the popup menu.

Automatically generated variable names are registered in the global variable table according to 
the following rule.

Automatic generation rule: The device variable name is added after the controller name and 
separated with an underline.

 Manually Entering New Variable Names

Select the device variable and directly enter the variable name in the Variable column.

4 Variable You can set the name of a HMI global variable. You can use entry assistance to 
select from a list of previously registered HMI global variables.

5 Variable Comment You can set comments for the HMI global variables. These comments are also 
applied to the global variable table.

3-3-3 Variable Mapping Methods

Creating New External Variables

No Item Description
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You can select global variables that are already registered in the global variable table and assign them 
to device variables.

For example, this method can be used to map external variables in the following cases.

• Setting an HMI global variable first and then assigning it to a device variable

• Creating a common project first and specifying connected devices later

Use the following procedure.

1 Register the global variables in the global variable table in advance.

2 When you map variables, you can select global variables from lists of variables that are already 
registered in the global variable table and assign them to device variables.

Selecting Previously Registered Global Variables and Mapping 
Them
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3-4 HMI Settings

This section describes the HMI settings.

You can make settings for an HMI.

The following table lists the setting items.

1 Double-click HMI Settings under Configurations and Setup in the Multiview Explorer. The 
HMI Settings Tab Page is displayed in the Configurations and Setup Layer.

2 Click the icons on the left to display the corresponding dialog boxes.

3-4-1 HMI Settings

Item Icon Description When setting is required

Device Settings There are page, screen saver, 
brightness settings, and other set-
tings.

These settings are always required.

TCP/IP Settings These are the Ethernet settings for 
Ethernet ports 1 and 2.

These settings are always required.

FTP Settings These are the FTP server settings. These settings are required to use 
the FTP server.

NTP Settings These are the NTP client settings. These settings are required when 
you use an NTP client.

FINS Settings These are the settings for FINS com-
munications.

These settings are required when 
using FINS communications with a 
CJ-series PLC.

VNC Settings These are the VNC settings. These settings are required to use 
VNC.

Setting Procedure for HMI Settings
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These are the device settings.

3-4-2 Device Settings

Item Description

Startup Page

Page name Sets the page to display first when the HMI is started.

Startup Language

Startup language Sets the project language to use when the HMI is started.

USB Keyboard

Key layout Sets the layout of a USB keyboard.

Security

Automatically log out user 
after period of inactivity.

Select this check box to automatically log out the user after a specified 
period of inactivity.

Inactivity period Specify the time of inactivity before the user is logged out automatically.

Screen Saver

Screen saver type Sets the type of screen saver.

Active after Sets the time after the screen is touched before the screen saver is started.

Screen Brightness

Screen brightness Sets the brightness of the screen.

System Menu

Double-tap Interval Sets the interval to use to detect double taps.

Detectable corner Select the corners in which to detect the operation to display the System 
Menu.
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These are the settings for TCP/IP.

The following settings are provided for Ethernet port 1 and Ethernet port 2.

3-4-3 TCP/IP Settings

Item Description

Ethernet Port 1 - Settings

IP Address Sets the local IP address.

Subnet mask Sets the subnet mask.

Default gateway Sets the IP address of the default gateway. This setting is not required when 
a default gateway is not used.

Primary DNS server Sets the IP address of the primary DNS server.

Secondary DNS server Sets the IP address of the secondary DNS server.

Primary WINS server Sets the IP address of the primary WINS server.

Secondary WINS server Sets the IP address of the secondary WINS server.

Ethernet Port 2 - Settings

Direct connection with Sys-
mac Studio

Select this check box to connect Ethernet port 2 directly to the Sysmac Stu-
dio without going through an Ethernet switch. If you select this check box, 
the IP addresses and other settings for Ethernet port 2 are ignored.

IP Address Sets the local IP address.

Subnet mask Sets the subnet mask.

Default gateway Sets the IP address of the default gateway. This setting is not required when 
a default gateway is not used.

Primary DNS server Sets the IP address of the primary DNS server.

Secondary DNS server Sets the IP address of the secondary DNS server.

Primary WINS server Sets the IP address of the primary WINS server.

Secondary WINS server Sets the IP address of the secondary WINS server.
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These are the FTP server settings.

3-4-4 FTP Settings

Item Description

FTP Settings

FTP server Specifies whether to use the FTP server of the HMI.

Login name Sets the login name to externally connect to Ethernet port 1 or 2 on the HMI 
via FTP. You can use up to 12 alphanumeric characters.

Password Sets the password to use to externally connect to Ethernet port 1 or 2 via FTP. 
You can use 8 to 32 alphanumeric characters.
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These are the settings for an NTP (Network Time Protocol) client.

The HMI gets the clock information from the specified NTP server at the specified interval and updates 
the built-in clock information.

3-4-5 NTP Settings

Item Description

NTP Settings

Synchronize with an Internet 
time server

Select this check box to synchronize the built-in clock in the HMI with the 
clock information from the NTP server.

NTP server Sets the IP address of the NTP server.

Interval Sets the interval at which to get the clock information from the NTP server.
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These are the settings for FINS communications.

These settings are required when FINS communications are used between the HMI and a CJ-series 
PLC.

3-4-6 FINS Settings

Item Description

FINS Address

Ethernet port #1 Sets the FINS network address of Ethernet port 1.

The FINS node address is automatically created from the IP address.

Ethernet port #2 Sets the FINS network address of Ethernet port 2.

The FINS node address is automatically created from the IP address.

FINS/UDP

FINS/UDP port no Displays the port number used for FINS/UDP.

Remote Network Table Sets the routing table.
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These are the settings for VNC (Virtual Network Computing).

VNC implements a remote desktop to allow remote control of a computer located on a network.

You must enable the server functionality on the HMI to control. You can start the client software on the 
computer from which to perform remote control, connect to the HMI, and then control it remotely.

3-4-7 VNC Settings

Item Description

VNC Settings

Enable VNC Specifies whether to use VNC.

Port No. Sets the port number.

Mode Sets the operations to enable from the VNC client.

Password Sets the password.
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3-5 Security Settings

These settings are used to restrict the operations that can be performed on the HMI and register 
accounts.

1 Double-click Security under Configurations and Setup in the Multiview Explorer.
The Security Settings Tab Page appears in the Configurations and Setup Layer.

Setting Procedure for Security Settings

Item Description

User Accounts Registers user accounts.

Roles and Access Levels Sets the access level for each role.

Security Settings Sets the level of operations to permit from the System Menu.
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3-6 Language Settings

These settings are used for multi-language projects.

There are two languages on the HMI.

• Project Language

The project language is displayed for the project that you create.

• System Language

The system language is displayed for the System Menu and for error messages displayed by the sys-
tem.

The two language settings are managed as pairs. If you change the project language, the paired sys-
tem language will also change.

1 Double-click Language Settings under Configurations and Setup in the Multiview Explorer. 
The Language Settings Tab Page appears in the Configurations and Setup Layer.

Additional Information

You can clear the selection of the Transfer to Device Check Box so that the language files are 
not transferred to the HMI. You can use this to delete unnecessary languages depending on the 
destination of the HMI.

Project Language and System Language

Language Setting Procedure

Item Description

Default language Sets the language that is displayed by default.

Other languages Sets the languages to add in addition to the default languages.
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3-7 HMI Clock

To set the clock in the HMI, select HMI Clock from the HMI Menu when you are online. Set the required 
items and click the Apply Button to update the information in the HMI.

Item Description

Time Zone

Computer Displays the time zone of the computer.

HMI Sets the time zone of the HMI

Automatically adjust clock for 
DST

Select this check box to enable automatically adjusting for daylight savings 
time.

Date and time

Computer Displays the current date and time on the computer.

Synchronize with computer Updates the clock information on the HMI with the clock information from the 
computer.

HMI Set the clock information on the HMI.
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3-8 Updating the HMI Name

To change the HMI name, select HMI Name from the HMI Menu when you are online.
A confirmation dialog box is displayed. To update the HMI name that is set in the project, click the Yes 
Button.
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3-9 Write Protecting the HMI

To write-protect the HMI, select Security - HMI Write Protection from the HMI Menu when you are 
online.

A confirmation dialog box is displayed. Click the Yes Button to write-protect the HMI.

Only the project is write-protected. The project can still log data and write other data.
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3-10 Clear All Memory

You can initialize the HMI.

When you perform the Clear All Memory operation, all data is cleared except for time data. To clear all 
memory in the HMI, select Clear All Memory from the HMI Menu when you are online.

A confirmation dialog box is displayed. Click the OK Button to clear all memory.
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3-11 Resetting the HMI

You can reset the HMI.

To reset the HMI, select Reset HMI Device from the HMI Menu when you are online. A confirmation 
dialog box is displayed. Click the Yes Button to reset the HMI.
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4-1 Registering Variables

A variable is a ‘container’ that holds data.

The HMI supports the following types of variables.

 Opening the Global Variable Tab Page

Double-click Global Variables under HMI - Data in the Multiview Explorer. Or, right-click Global 
Variables under HMI - Data and select Edit from the menu.

4-1-1 Variables

Variable type Description

Global variables Global variables are defined by the user and can be accessed from anywhere in the 
project. You can register up to 35,000 total in the entire project and up to 20,000 for 
each connected device.

Global variables are declared in the HMI global variable table.

Global variables include external variables and internal variables, which are 
described below.

External variables External variables are global variables that are used to access data in Controllers 
and other connected devices.

External variables are assigned to device variables in the variable mapping.

Internal variables An internal variable can be used only within the HMI.

All global variables that are not external variables are internal variables.

System-defined 
variables

System-defined variables are provided in advance in the HMI. The names and all 
attributes are defined by the system. They have specific functions.

You cannot change the variable names or any other attributes of these variables.

Subroutine variables Subroutine variables are defined by the user and are used only within subroutines.

Subroutine variables are declared in Dim statements in page subroutines or global 
subroutines.

You can use all of the data types that are supported by Visual Basic.

4-1-2 Registering Global Variables
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The global variable table is displayed in the HMI Layer.

The basic Sysmac Studio operations for the global variable table generally apply to HMIs. Refer to 
the Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for the basic operations.

However, the following items are different. Refer to 4-1-4 Attributes and Entry Methods for Global 
Variables on page 4-5.

Additional Information

Even if you change the name of a previously registered global variable, the name of the vari-
able accessed from objects or subroutines will not change.

Item Description

Name There are specific prohibited characters that apply to HMIs.

Data Type There are specific data types for HMIs.

AT You can set the device variables to which to assign the global variables. This setting is 
not used for internal variables.

Update Rate You can select the interval at which to get values from the connected device. This set-
ting is used only for external variables.
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External variables are global variables that are used to access data in connected devices.

External variables are created in the variable mapping.

The global variables are mapped to the connected device variables.

In the variable mapping, you can create new variables or you can select variables that were previously 
created.

If you create a new external variable in the variable mapping, it will automatically be registered as a 
global variable.

Refer to 3-3 Mapping Variables on page 3-7 for details on the variable mapping.

If you create a new external variable in the variable mapping, the following attributes are registered for 
it in the global variable table.

Refer to 4-1-5 System-defined Variables on page 4-8 for details on the attributes of variables.

4-1-3 Registering External Variables

External Variables

Creating External Variables

Attributes of External Variables

Attribute Setting
Changes to set-

tings

Name Specified variable name Possible.

Data Type Refer to the NA-series Programmable Terminal Device Connection 
User’s Manual (Cat. No. V119) for details on data type for the HMI 
global variables based on data types for device variable.

Possible.

Initial Value None Not possible.

AT Device_name.Device_variable_name Possible.

Retain Non-retained Not possible.

Constant None Not possible.

Update Rate 500 ms Possible.

Comment Specified comment Possible.
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This section describes attributes and entry methods for global variables.

 Name Attribute

Enter a text string for the name. Observe the following restrictions.

• You cannot use any symbols except for underscores.

• The first letter cannot be a number.

• The names are not case sensitive.

• You cannot use names that start with “_HMI”.

• You cannot use names that are reserved for the Sysmac Studio or Visual Basic.

• You cannot use more than 127 characters.

4-1-4 Attributes and Entry Methods for Global Variables

Attributes of Global Variables
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 Data Type Attribute

Enter a data type directly or select one from the list.

You can use the following data types, which are supported by Visual Basic. Arrays of the data types that 
are supported by Visual Basic are also supported. If you specify an array, specify the element number 
in parentheses after the data type in the same way as in Visual Basic.

Refer to the NA-series Programmable Terminal Device Connection User’s Manual (Cat. No. V119) for 
information on which of the above HMI variable data types can be assigned to the data types of con-
nected device variables for different connected devices.

Classifica-
tion

Data type
Data type 

name
Size Range of values

Basic data 
types

Boolean Boolean ― True or False

Byte Byte 1 byte 0 to 255 (unsigned)

Char Char 2 bytes 0 to 65,535 (unsigned)

Date Date 8 bytes 0:00:00 (midnight) on January 1, 0001 through 
11:59:59 PM on December 31, 9999

Decimal Decimal 16 bytes 0 through 
+/-79,228,162,514,264,337,593,543,950,335 
(+/-7.9...E+28) with no decimal point;  
0 through +/-7.9228162514264337593543950335 
with 28 places to the right of the decimal; 
smallest nonzero number is 
+/-0.0000000000000000000000000001 (+/-1E-28)

Double Double 8 bytes -1.79769313486231570E+308 through 
-4.94065645841246544E-324 for negative values;

4.94065645841246544E-324 through 
1.79769313486231570E+308 for positive values

Integer Integer 4 bytes -2,147,483,648 through 2,147,483,647 (signed)

Long Long 8 bytes -9,223,372,036,854,775,808 through 
9,223,372,036,854,775,807 (9.2...E+18) (signed)

SByte SByte 1 byte -128 through 127 (signed)

Short Short 2 bytes -32,768 through 32,767 (signed)

Single Single 4 bytes -3.4028235E+38 through -1.401298E-45 for negative 
values;

1.401298E-45 through 3.4028235E+38 for positive 
values

String String Variable 
length

0 to approximately 2 billion Unicode characters

UInteger UInteger 4 bytes 0 through 4,294,967,295 (unsigned)

ulong ULong 8 bytes 0 through 18,446,744,073,709,551,615 (1.8...E+19) 
(unsigned)

ushort UShort 2 bytes 0 to 65,535 (unsigned)

Derivative 
data types

TimeSpan Structure that gives a time interval

Structures To use structures as global variables, you must import them from a connected 
device. You can use subroutine variables if you declare them inside the subrou-
tine.

Unions Unions are not supported.

Enumerations Enumerations are supported only in subroutines.
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 Initial Value Attribute

Specify a value for the variable for one of the following situations when the Retain attribute is not 
specified.

• When the power supply is turned ON

• When you specify to initialize the value when the project is transferred

Enter a value directly or select an item from the list (the values in the list depend on the data type). If 
you do not enter an initial value, 0 is used as the initial value.

Select None for no initial value. You cannot specify the Initial Value attribute for an external variable.

 AT Attribute

This attribute is specified for external variables. Use the following format.

Device_name.Device_variable_name

 Retain Attribute

Specify whether to retain the value of the variable in the following cases.

• When the power supply is turned ON

• When you do not specify to initialize the value when the project is transferred

You cannot specify the Retain attribute for an external variable.

 Constant Attribute

If you set the Constant attribute, you can set the initial value of the variable when the project is 
downloaded, but you cannot overwrite the value afterward.

You cannot specify the Constant attribute for an external variable.
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 Update Rate Attribute

The update interval with the connected device is specified for external variables. If None is set for an 
external variable, the external variable will be treated as an internal variable. In that case, no com-
munications for the variable will be performed with the connected device. You do not need to specify 
this attribute for an internal variable.

 Comment Attribute

Enter a comment.

System-defined variables are internal variables that are pre-defined by the system. All system-defined 
variable attributes are fixed. The names and all other attributes of these variables are defined, and spe-
cial functions are assigned to them. You cannot change the names or any other attributes.

• You can use the system-defined variables for an HMI as soon as you register an HMI in the project. It 
is not necessary to register system-defined variables in the global variable table.

• System-defined variables that are related to an HMI start with “_HMI_”.

4-1-5 System-defined Variables

System-defined Variables
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System-defined Variables

Variable name Meaning Description
Data 
type

R/W

_HMI_Brightness Brightness Sets the brightness of the screen. Integer R/W

_HMI_CanEjectSDCard Can Eject SD 
Card

Tells whether you can remove the SD 
Memory Card.

True: Ejection is not possible, False: 
Ejection is possible.

Boolean R

_HMI_CurrentPage Current Page 
Name

Sets the name of the currently dis-
played page.

String R/W

_HMI_DateTime System Time Gives the system clock time as the 
local time.

Date-
Time

R

_HMI_Hour Current Hour Gives the hour in the current time. Integer R

_HMI_IsBatteryLow Low Battery Volt-
age

Gives True if the battery voltage has 
dropped below a specific level.

Boolean R

_HMI_IsDataInput Data Entry in 
Progress

Gives True when a data entry object is 
selected.

Boolean R

_HMI_IsPageSwitching Page Switching in 
Progress

Gives True while page switching pro-
cessing is in progress and False after 
processing is completed.

Boolean R

_HMI_IsScreenSaverActive Screen Saver Sta-
tus

Tells whether the screen saver is 
active.

True: Active, False: Not active.

Boolean R/W

_HMI_ManagedRAMInUse Usage of Man-
aged RAM

Gives the total bytes of managed RAM 
that is currently allocated to some pro-
cess.

ULong R

_HMI_Millisecond Current Millisec-
onds

Gives the milliseconds in the current 
time.

Integer R

_HMI_Minute Current Minutes Gives the minutes in the current time. Integer R

_HMI_RAMInUse Usage of RAM Gives the total bytes of RAM that is 
currently allocated to some process.

ULong R

_HMI_RAMTotal Total RAM Gives the total bytes of RAM that the 
system is using or can use. This is not 
the currently usable amount of RAM.

ULong R

_HMI_RunSignal Run Signal Changes periodically while the HMI is 
operating.

Boolean R

_HMI_Second Current Seconds Gives the seconds in the current time. Integer R
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 Alarm-related Variables

 User and Security

Subroutine variables can be used only with subroutines. Subroutine variables conform to Visual Basic 
specifications.

Refer to the NA-series Subroutine Reference for details.

Variable name Meaning Description
Data 
type

R/W

_HMI_AlarmCount Alarm Count Gives the number of alarms that have 
occurred since startup.

Integer R

_HMI_AlarmsClearedNotAck Cleared Unac-
knowledged 
Alarms

Gives the number of alarms that are 
cleared but not acknowledged.

Integer R

_HMI_AlarmsNotAck Unacknowledged 
Alarm Count

Gives the number of alarms that are 
not acknowledged.

Integer R

_HMI_AlarmsRaised Current Alarm 
Count

Gives the number of current alarms. Integer R

_HMI_AlarmsRaisedNotAck Unacknowledged 
Current Alarm 
Count

Gives the number of current alarms 
that are not acknowledged.

Integer R

Variable name Meaning Description
Data 
type

R/W

_HMI_CurrentUserName Current User 
Name

Gives the name of the user that is cur-
rently logged in.

String R

_HMI_CurrentUserRole Current User 
Authority

Gives the authority (role) of the user 
that is currently logged in.

String R

4-1-6 Subroutine Variables

Subroutine Variables
4 - 10 NA Series Programmable Terminal Software User’s Manual (V118)



4   Creating the HMI Application
4-2

  C
reatin

g
 P

ag
es

4

4-2 Creating Pages

One page represents one screen in the HMI project.

You can arrange various objects on a page to achieve the required functions.

There are two types of pages, as described in the following table.

 Main Pages

The main pages are the basic pages. You can create applications to call popup pages from main 
pages or move to other main pages. You can place up to 450 objects on one main page.

You can create layers of main pages.

You can specify a background page to make the top layer transparent and place a specified page 
underneath it. You can layer up to five pages including the main pages.

You can create a common page, e.g., with a toolbar, to display with all other pages and then specify 
it as the background page so that you do not have to create it more than once.

 Popup Pages

Popup pages are called from main pages. Use them to display warnings and other information. You 
can place up to 450 objects on one popup page. You cannot display more than one popup page at 
the same time. A popup page is always displayed in the middle of the main page. No operations are 
possible on the main page while a popup page is displayed.

Page Type in the Page Behavior Sizes (width and height) Application

Main Fixed for each model Basic pages

Pages can be layered.

You can specify a transparent color 
and specify a background page.

Popup You can set the page sizes as long 
as they are not larger than the main 
page size.

Warning dialog boxes and other 
applications

The maximum size is fixed.

The maximum 
size is fixed.

Main Pages

You can specify 
any size that is 
not larger than 
the maximum 
size.

Popup Pages

You can specify any 
size that is not larger 
than the maximum size.

Main pages

Page 1

Page 2

Page 3

Page 1: Transparent background

Page 2: Transparent background

Page 3: Background color
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Click Pages under HMI in the Multiview Explorer.

The pages are displayed under Pages.

You can assign various functions to the pages, and use different pages to implement different functions.

The project contains one page by default, and you can add more pages as required.

1 Right-click Pages under HMI and select Add - Page from the menu.

A new page, Page1, is added under Pages.

1 Right-click the page to delete in the Multiview Explorer and select Delete from the menu.

A deletion confirmation dialog box is displayed.

Click the Yes Button. The page is deleted.

4-2-1 Displaying Pages

4-2-2 Registering Pages

Registering New Pages

Deleting Pages
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1 Select the page to copy in the Multiview Explorer and press the Ctrl + C Keys. Or, right-click the 
page and select Copy from the menu.

The page is copied.

2 Select Pages in the Multiview Explorer and press the Ctrl + V Keys. Or, right-click Pages and 
select Paste from the menu.

The copied page is registered with “Copy_1_of_” added to the front of the name of the page that 
was copied. All of the contents of the page are also copied.

Additional Information

• You can change the names of pages. Right-click the page and select Rename from the 
menu.

• If you copy a page from another product and a page with the same name already exists, the 
page will be named as a copy.

Copying and Pasting Pages
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You can set properties for the pages.

1 Right-click in a location in the Edit Pane where there is no object and select Properties.

2 Set the properties for the page in the Properties Window that is displayed.

Click the arrowhead ( ) at the right of each item to make selections.

If you select a popup for the behavior setting, you can increase and decrease the width and 

height layout sizes with the arrowheads  on the right side of the box after first selecting the 
size to change (left: width, right: height).

4-2-3 Page Property Settings

Setting Properties

Item classifi-
cation

Item Setting Remarks

General Name Defaults: Page0, Page1, 
Page2, etc.

All names must be unique.

Type Page (Cannot be 
changed)

Appearance Background Color Select the color.

Default: Black

A transparent page will automati-
cally be set if a background page 
is specified.

Behavior PageType Main or Popup

BackgroundPage Select a previously cre-
ated page.

A background page can be set 
only for a main page.

Layout Size (Width, Height) The default is the maxi-
mum size for the model.

You can change the size if the 
behavior setting described 
above is set to a popup. You 
cannot change the size of main 
pages.
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You can arrange objects on the pages to achieve the required functions.

Drag objects from the Toolbox to position them on a page.

To move an object, click the object and drag it while the cross cursor is displayed.

4-2-4 Editing Pages

Positioning Objects

Moving Objects
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Click one of the resize handles around the object and drag it while the resizing cursor is displayed.

Click the rotation handle  to the upper right of the object and drag it while the angle is displayed in the 
center of the object.

The functions that are commonly used to edit pages are provided in the Toolbar.

 Group

This button creates a group of objects.

 Ungroup

This button ungroups previously grouped objects.

 Edit

This button is used to edit graphic objects and other objects.

 Rotate Right 90 Degrees

This button rotates an object 90° clockwise.

 Rotate Left 90 Degrees

This button rotates an object 90° counterclockwise.

 Flip Vertical

This button flips a graphic object vertically.

Resizing Objects

Rotating Objects

Editing with the Toolbar
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 Flip Horizontal

This button flips a graphic object horizontally.

 Bring to Front

This button moves an object to the front.

 Bring Forward

This button moves an object toward the front.

 Send Backward

This button moves an object toward the back.

 Send to Back

This button moves an object to the back.

 Align Left

This button aligns the left edges of the selected objects.

 Align Center Vertical

This button aligns the centers of the selected objects vertically. 

 Align Right

This button aligns the right edges of the selected objects.

 Align Top

This button aligns the top edges of the selected objects.

 Align Center Horizontal

This button aligns the centers of the selected objects horizontally. 

 Align Bottom

This button aligns the bottom edges of the selected objects.

 Distribute Horizontally

This button positions the centers of the objects at equal distances horizontally.

 Distribute Vertically

This button positions the centers of the objects at equal distances vertically.

 Change Language

This box changes the project language that is displayed in the Edit Pane.
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4-3 Setting Common Object Functions

This section describes the settings for functions that are shared by the entire HMI project.

The following functions are provided.

• User alarms

• Data logging

• Recipes

• Global events

• Global subroutines

• Resources

• IAG resources

You can specify conditions for specified variables to display user messages when the conditions are 
met.

You can use this to record information when errors occur, when operation is started, etc.

You manage user alarms by group.

The groups are displayed in the User Alarms Viewer and are helpful in organizing information.

1 Right-click HMI under User Alarms in the Multiview Explorer and select Add - Group from the 
menu.

Group1 is added under User Alarms.

4-3-1 Registering User Alarms

User Alarms

Registering a New User Alarm
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2 Double-click the new group.

A tab page to edit the group is displayed in the HMI Layer of the Edit Pane so that you can reg-
ister user alarms.

You can delete, copy, and paste groups using the same procedures as those that you use for pages.

Deleting, Copying, and Pasting Groups
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You can use data logging to store the changes in the values of specified variables over time.

You can display the saved data with Trend Graph objects. You can also save this data to external files.

To log data, you must create one or more data sets. You can create different data sets to change the 
location where the data is saved.

1 Right-click HMI - Data Logging in the Multiview Explorer and select Add - Data Set from the 
menu.

DataSet0 is added under Data Logging.

2 Double-click the new data set.

A tab page to make settings for the data set is displayed in the HMI Layer of the Edit Pane. You 
can set the variables to log, the storage locations, and other parameters.

You can delete, copy, and paste data sets using the same procedures as those that you use for pages.

4-3-2 Registration for Data Logging

Data Logging

Registering a New Data Set

Deleting, Copying, and Pasting Data Sets
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A recipe is used to write data (numeric data or text strings) that was set in advance in the HMI to all of 
the specified variables as a group or to read all of the specified variables as a group.

You can manipulate the registered recipe data with Recipe Viewer objects.

To use recipes you must create them.

1 Right-click HMI - Recipe in the Multiview Explorer and select Add - Recipe Template from the 
menu.

Recipe0 is added under Recipes.

2 Double-click the new Recipe0. A tab page to make settings for Recipe0 is displayed in the HMI 
Layer of the Edit Pane. You can set the variables to use and other parameters.

You can delete, copy, and paste recipes using the same procedures as those that you use for pages.

4-3-3 Registering Recipes

Recipes

Registering a New Recipe

Deleting, Copying, and Pasting Recipes
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Global events occur at the project level and do not belong to any specific page.

When a global event occurs, the action that is assigned to the event is executed.

 Global Events

Global events include function key operations, changes in the values of variables, starting the proj-
ect, etc. A list of the events that you can set is provided in A-1 Events and Actions on page A-2.

 Actions

You can specify the action to perform when a global event occurs from a list of predefined actions. 
Actions include executing global subroutines and other system-defined operations. A list of the 
actions that you can set is provided in A-1 Events and Actions on page A-2.

To set up a global event, you select the global event and then set the action to execute when the event 
occurs.

1 Right-click HMI - Global Events in the Multiview Explorer and select Edit from the menu. Or, 
double-click HMI - Global Events.

2 A tab page to make settings for the global event is displayed in the HMI Layer of the Edit Pane.

3 Click in the column on the right to select the event to set from the event list.

A global event is added.

4-3-4 Setting Global Events and Corresponding Actions

Global Events

Setting Up Global Events
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4 In the Actions row below the new global event, click in the right column and select the action to 
perform for the event from the action list.

5 When you add global events, they are numbered serially from 0 in the order that you add them.

To delete all of the settings for global events, right-click the Events header at the top and select Reset.

To delete an individual event, click the  Button on the right edge of the event.

Deleting Global Events
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You can register global subroutines, which you can then call from anywhere in the project.

You can register common subroutines that do not rely on page conditions to make subroutines easier to 
maintain.

To register global subroutines, you must create one or more subroutine groups. You can use subroutine 
groups to separate subroutines by purpose.

1 Right-click HMI - Global Subroutines in the Multiview Explorer and select Add -Group from 
the menu.

SubroutineGroup1 is added under Subroutine Groups.

2 Double-click the new subroutine group. A tab page for the Code Editor is displayed in the HMI 
Layer of the Edit Pane.

You can delete, copy, and paste subroutine groups using the same procedures as those that you use 
for pages.

4-3-5 Registering Global Subroutines

Global Subroutines

Registering a New Subroutine Group

Deleting, Copying, and Pasting Subroutine Groups
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Resources are the text strings, movies, still images, and documents that are displayed for objects and 
alarms on user pages.

You can use Resources to manage all of the text strings, images, files, and other resources that you 
use in a project.

For multi-language projects, you can set resources for each project language.

To set up a resource, select the resource to set up and then make the settings.

1 Right-click HMI - Resources in the Multiview Explorer and select Edit from the menu. Or, dou-
ble-click HMI - Resources.

2 A tab page to make settings for resources is displayed in the HMI Layer of the Edit Pane. You 
can select the resource to set and make the settings.

4-3-6 Setting Up Resources

Resources

Setting Up Resources
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IAG resources are used within IAGs on user pages. When you place an IAG on a page, the resources 
for the IAG are automatically registered.

The languages that are displayed by the IAG resources are determined by the project languages. The 
resources that are set in advance for the IAGs are displayed for the IAG resources. If a language that is 
not included in an IAG is set as a project language, the resources will be blank by default.

To set up an IAG resource, select the IAG resource to set up and then make the settings.

1 Right-click the IAG resource to edit under HMI - IAG Resources in the Multiview Explorer and 
select Edit from the menu. Or, double-click the IAG resource.

2 A tab page to make settings for IAG resources is displayed in the HMI Layer of the Edit Pane. 
The procedures are the same as for other resources, but you can change only the contents of 
the resources that are in the IAGs.

4-3-7 Setting Up IAG Resources

IAG Resources

Setting Up Resources
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4-4 Subroutines

Subroutines are Visual Basic programs that the user can create. You create subroutines under Subrou-
tines in the HMI project.

Precautions for Correct Use

This manual describes only aspects that are different from the specifications standardized by 
Microsoft Corporation. For any specifications not given in this manual, refer to commercially 
available reference materials.

There are global subroutines and page subroutines, as described below.

 Global Subroutines

Global subroutines are shared by the entire project.

You create global subroutines under Global Subroutines in the HMI project. You set CallSubRou-
tine as the action in a global event, object event, or user alarms event to call a global subroutine.

You can also call a global subroutine from a page subroutine or from another global subroutine.

 Page Subroutines

Page subroutines are specific to one page.

You create page subroutines with the Code Editor for a page in the HMI project.

You can directly create the subroutines to execute in the events for individual objects on pages.

Subroutines

Subroutines
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You can execute subroutines in the following ways.

• Execution from Global Events

You can execute a global subroutine from a global event.

• Execution from Page and Object Events

You can execute a page subroutine or global subroutine from a page or object event.

• Execution from User Alarm Events

You can execute a global subroutine from a user alarm event.

The following example shows how to use a global event to execute a global subroutine.

In this example, settings are made to execute the global subroutine when the F1 Key is pressed.

1 Display the global events and select F1KeyPress as the event.

2 Select CallSubRoutine as the action.

3 For the subroutine name, specify the name of a previously created subroutine in the following 
format: Subroutine_group.Subroutine_name

4-4-1 Subroutine Execution

Execution from Global Events
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The following example shows how to use an object event to execute a subroutine.

In this example, settings are made to execute the subroutine when a Button object is pressed.

1 Select the Button object and display the events and actions.

2 Select Press as the event.

3 Select CallSubRoutine as the action.

4 Specify the subroutine to execute in the following format: Subroutine_group.Subroutine_name

Execution from Objects
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The following example shows how to use a user alarm event to execute a subroutine.

In this example, settings are made to execute the subroutine when the user alarm occurs.

1 Select the user alarm and display the events and actions.

2 Select Raised as the event.

3 Select CallSubRoutine as the action.

4 Specify the subroutine to execute in the following format: Subroutine_group.Subroutine_name

Execution from User Alarms
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 Handling of Variables

If the value of an external variable is changed in a subroutine, the change is immediately updated at 
the connected device. Therefore, if you frequently change the value of an external variable inside a 
subroutine, the performance of that subroutine will be reduced.

 Processing during Subroutine Execution

The touch panel and function keys will not respond during execution of a page subroutine. If you 
execute processing that requires time, the HMI will not perform other operations until the processing 
is completed. Consider the execution time when you create subroutines. However, processing will 
continue for background operations, such as communications, and for page refreshing.

 Simultaneous Execution of Subroutines

It is possible that a subroutine for a global event and a page subroutine will be executed simultane-
ously. If both subroutines manipulate the same variable, implement exclusive control or other suit-
able measures.

Subroutines are edited with the Code Editor.

 Global Subroutines

Double-click a previously registered subroutine under HMI - Global Subroutines in the Multiview 
Explorer. Or, right-click the subroutine and select Edit from the menu.

 Page Subroutines

Right-click a previously registered page name under HMI - Pages in the Multiview Explorer and 
select View Code from the menu.

The Code Editor provides functions equivalent to those of a standard text editor. It also provides func-
tions that are optimized for Visual Basic, such as keyword highlighting, entry assistance, and collapsing 
Sub statements.

Although subroutines are used in Visual Basic, some of the functions are restricted for HMIs. There are 
also extensions that are provided for use with HMIs. Refer to the NA-series Subroutine Reference for 
details.

4-4-2 Precautions on Internal Processing

4-4-3 Code Editor

Starting the Code Editor

Code Editor Features

4-4-4 Differences in Language Specifications
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4-5 Search and Replace

You can search and replace strings in the data of an HMI subroutine. The basic Sysmac Studio opera-
tions for searching and replacing generally apply to HMIs. Refer to the Sysmac Studio Version 1 Oper-
ation Manual (Cat. No. W504) for details.

The following differences apply when an HMI is selected.

• The Look at what Box can be set only to Programming, i.e., only the contents of the subroutine is 
searched.

• You can select only All for the Look at Box.

Differences When an HMI Is Selected
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4-6 Building

The project must be built to convert it into a form that the HMI can execute.

During the building process, subroutines and variables are checked.

If there are any errors, the build operation is not performed and  is displayed next to the program or 

variable where the error occurred in the Multiview Explorer.

You can confirm the errors on the Build Tab Page.

Use the main menu to execute the build operation. HMI projects are not built automatically even if no 
operations are performed for 5 seconds.

1 Select Build HMI from the Project Menu.

No functions can be executed while building the project is in progress. If necessary, you can abort build-
ing to check the project.

1 Select Abort Build from the Project Menu.

2 The build operation is aborted and a message that says it was aborted is displayed in the Out-
put Tab Page.

4-6-1 Building

4-6-2 Build Operation

Executing a Build Operation

Aborting a Build Operation
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4-7 Offline Comparison

HMI projects are not included in offline comparisons. Even if you perform an offline comparison for a 
project that contains an HMI as a device, information on the HMI is not included in the comparison 
results.
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5-1 Objects

Basic objects are provided in the Sysmac Studio as standard features. You can use these objects to 
easily create pages.

The following objects are provided.

A functional object provides some sort of function by itself.

5-1-1 Object List

Functional Objects

Classification Object name Description

Buttons Button object Used to execute an action without writing a value to a variable.

Momentary Button 
object

Used to change the value of the specified variable to True only while 
the object is being touched.

Set Button object Used to change the value of the specified variable to True when the 
object is touched.

Reset Button object Used to change the value of the specified variable to False when the 
object is touched.

Toggle Button object Used to toggle the value of the specified variable between True and 
False when the object is touched.

Lamps Bit Lamp object Lit while the result of the condition expression is True.

Data Lamp object Used to change the color of the lamp according to the value of a condi-
tion expression.

Standard con-
trols

CheckBox object Used to change a variable to True or False depending on whether the 
check box is selected. Also, the check box can be displayed when the 
value of the specified variable changes.

Data Display object Used to display numeric values or text strings.

Data Edit object Used to display and enter numeric values or text strings.

DateTime object Used to display the value of a variable as a date and time.

DropDown object Used to store the value that corresponds to the item selected in a 
drop-down list in a variable. Also, the item that corresponds to the 
specified variable value is displayed.

Image object Used to display an image. Refer to A-2 Supported Formats on page 
A-4 for the supported formats.

Label object Used to display a fixed text string. Also, if you use DisplayValue for the 
animation property, you can display the value of the variable.

ListBox object Used to store the value that corresponds to the item selected in a list in 
a variable. Also, if the value of the specified variable is changed, you 
can move the focus to an item that corresponds to the new value of the 
variable.

Radio Button object Used to set the specified variable to the value that was set for the 
selected button. Only one of the specified group of buttons can be 
selected. Also, the option button can be displayed when the value of 
the specified variable changes.

Slider object Used to set the specified variable to the value that corresponds to the 
position of the slider. Also, if the value of the specified variable is 
changed, you can move the slider to the position that corresponds to 
the new value.

TextBox object Used to display a fixed text string. A TextBox object differs from a Label 
object in that the text string in a TextBox object will wrap.
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A graphic object does not provide any specific function by itself. You must add functions by using 
events and actions. Many different graphic objects are available. Some typical ones are described in 
the following table.

There are the following three types of attributes for objects.

• Properties

• Animations

• Events and actions

Gauges Gauge Object There are several types of gauges provided, such as one with a needle 
that rotates in a circle and one with a needle that moves in a straight 
line.

HMI controls Media Player object Used to create an object that plays video. Refer to A-2 Supported For-
mats on page A-4 for the supported formats.

Recipe Viewer object Used to display the contents of a recipe.

Trend Graph object Used to display data from data logging as a graph.

User Alarms Viewer 
object

Used to display a user alarm.

Graphic Objects

Classification Object name Description

Shapes Curve object Used to draw a curved line. You can double-click the graphic object to 
edit it.

Ellipse object Used to draw a circle or ellipse.

Line object Used to draw a straight line. You can double-click the graphic object to 
edit it.

Polygon object Used to draw a polygon. You can double-click the graphic object to edit 
it.

Polyline object Used to draw connected straight lines. You can double-click the 
graphic object to edit it.

Rectangle object Used to draw a rectangle.

Triangle object Used to draw a triangle. You can double-click the graphic object to edit 
it.

5-1-2 Object Attributes

Classification Object name Description

Objects

Properties 

Animations

Events and actions

These are static attributes.

These attributes control object animations when the specified 
condition expressions are met.

You can specify events and the actions to perform 
when the events occur.

Type of attribute 
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 Properties

Properties are the static attributes of an object.

These include settings for the names and other general properties, colors, positioning, and other 
display properties, and assigned condition expressions or variables, as described in the following 
table.

Properties

Properties

Properties Description

General You can set the name of the object and check the object type.

Appearance You can set the object color, shape, label, etc.

Behavior You can set condition expressions, variables, and delay times to assign to 
the object.

Expression You can specify a condition expression that uses variables.

Variable You can specify a variable.

IsEnabled, DoubleTouch-
Time, OnDelayTime, etc.

You can make settings to enable the object, determine the double-touch 
interval, set the ON-delay time, etc.

Layout You can set the position and size of the object.

Security You can set security for the object.

Pointer Marker You can set the needle marker for a gauge.

Ranges You can set the range for a gauge.

Scale Bar You can set the scale bars for a gauge.

Tick Label You can set scale labels for a gauge.

Tick Major You can set the major scale division labels for a gauge.

Tick Minor You can set the minor scale division labels for a gauge.

Needle You can set the needle for a gauge.

Needle Cap You can set the needle cap for a gauge.

Data You can set the data set for data logging.

Left Axis You can set the left axis for a graph.

Right Axis You can set the right axis for a graph.

Time Scale You can set the time axis for a graph.
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 Notation for Expression

If you specify a BOOL variable, e.g., for a Lamp object, you can specify an expression for the 
Behavior property.

Examples of the expression notations are given below.

Example 1: Executing a Function when a Boolean Variable (blnSample in this Example) Is True

blnSample=True

Example 2: Executing a Function when an Integer Variable (intSample in this Example) Is Less 
Than 20

intSample<20

Example 3: Executing a Function when a Boolean Variable (blnSample in this Example) Is True and 
an Integer Variable (intSample in this Example) Is Less Than 20.

(blnSample=True) AND (intSample<20)

Example 4: Setting a Value by Adding 100 to an Integer Variable (intSample in this Example)

intSample+100

 Notation for CustomDisplayFormat

If you set DisplayFormat to Custom for a Data Display object, you must set the custom display for-
mat (CustomDisplayFormat). The basic format is 0:*****, where ***** is replaced with the result of 
Expression.

This format follows the specifications of custom numeric format strings in Visual Basic. For details, 
refer to the Microsoft website or to commercially available reference materials.

Example 1: Display When Result of Expression is 1.234 and {0:00.0000} Is Specified

01.2340

Example 2: Display When Result of Expression is 1.234 and {0:##.####} Is Specified

1.234

Example 3: Display When Result of Expression is 1.234 and X={0:##.####} Is Specified

X=1.234
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 Animations

You can use animations to change the status of the object according to Expression (condition 
expression).

As described below, you can specify the status when the condition expression is met, such as flash-
ing, enabling/disabling operation, size/coordinate changes, and displaying/hiding the object.

Animation List

 Events and Actions

You can make settings for object events and corresponding actions.

You can specify events and the actions to perform when the events occur.

You can specify the required conditions and operations, such as executing a specified subroutine 
when a function key is touched.

The events and actions are listed in A-1 Events and Actions on page A-2.

Animations

Animation name Description

Blink When the condition expression is met, the object flashes in the specified color.

ColorChange(Analog) Changes the color of the object according to a value.

ColorChange(Boolean) Changes the color of the object according to True/False status.

DisplayValue Displays a value based on a condition expression.

Enable Enables operating the object when the condition expression is met.

Move Changes the coordinates of the object according to specified condition expres-
sions.

PercentageFill Fills a graphic figure based on a condition expression and a percentage 
between the upper and lower limits.

ResizeHeight Changes the height of the object according to a specified condition expression.

ResizeWidth Changes the width of the object according to a specified condition expression.

Rotate Rotates a graphic object based on a condition expression.

Visibility Displays the object when a condition expression is met.

Events and Actions
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The objects are provided in the Toolbox on the right side of the window.

You can create them on pages and set the properties and animations and also the events and actions.

1 Drag the objects from the Toolbox and drop them on the page.

5-1-3 Using Objects

Creating Objects
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1 Select Properties from the View Menu.

2 The properties are the static attributes of the objects.

Setting Properties
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Make the following settings as required.

1 Select Animations from the View Menu.

2 You can set the animations of the objects in the Animations Window.

Setting Animations
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1 Select Events and Actions from the View Menu.

2 You can set the actions for events in the Events and Actions Window.

Setting Events and Actions
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5-2 Examples of Using Objects

This section provides examples of using objects.

The following example shows how to display a PDF file full screen when a button is touched.

1 Place a button on the page.

2 Select Events and Actions from the View Menu.

3 Select Click as the event.

5-2-1 Displaying a PDF File
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4 Select ShowDocument(FullScreen) as the action.

5 Set the name of the file to display.

Transfer the project to the HMI and confirm the operation.

The PDF file should be displayed when the button is touched.
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The following example shows how to register a user alarm and display a message when the user alarm 
occurs.

This example creates a user alarm that displays the message Alarm1 in a confirmation dialog box when 
the blnAlarm1 variable changes to True.

1 Right-click HMI under User Alarms in the Multiview Explorer and select Add - Group from the 
menu.

2 Double-click the new group.

3 Right-click in the user alarm table for the new group and select Add from the menu.

4 A row is added. Make the following settings in the new row. Use the default values for settings 
that are not specified.

Name: UserAlarm1

Expression: blnAlarm1=True

Message: Alarm1

Popup: Selected

Acknowledge: Selected

5-2-2 Displaying a User Alarm
5 - 13NA Series Programmable Terminal Software User’s Manual (V118)



5   Objects
5 Double-click HMI - Pages - Page0 in the Multiview Explorer. Drag a User Alarms Viewer object 
from HMI Controls in the Toolbox to the page.

Transfer the project to the HMI and confirm the operation.

When the blnAlarm1 variable changes to True, the contents that was set for the User Alarms 
Viewer object are displayed in a confirmation dialog box.
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The following example shows how to register a data set for data logging and display a trend graph that 
accesses it.

This example records log data continuously every 5 seconds and saves it in a separate file for each 
24-hour period.

1 Register an integer variable called intDatalog1 in the global variable table.

2 Right-click HMI - Data Logging in the Multiview Explorer and select Add - Data Set from the 
menu.

3 Double-click the new data set.

4 Right-click in the new data set grid and select Add from the menu.

5 A row is added. Set intDatalog1 in the Variable column of the new row. Use the default values 
for other settings.

5-2-3 Displaying a Trend Graph
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6 Double-click HMI - Pages - Page0 in the Multiview Explorer. Drag a Trend Graph object from 
HMI Controls in the Toolbox to the page.

7 Set the name of the data set that you created as the data set in the properties.

8 Click the  for Analog Traces and set the variable to display on the graph.

Set intDatalog1 as the variable.

Insert an SD Memory Card into the HMI, transfer the project to the HMI, and confirm the opera-
tion.
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Every 5 seconds, the value of intDatalog1 should be sampled and displayed on the graph.

The following example shows how to use a recipe.

1 Register integer variables called intRecipe1 and intRecipe2 in the global variable table.

2 Right-click HMI - Recipes in the Multiview Explorer and select Add - Recipe Template from the 
menu.

3 Double-click the new recipe template.

4 Register ingredients in the recipe template for the new recipe, Recipe0.

Right-click in the grid and select Add from the menu.

5-2-4 Using a Recipe
5 - 17NA Series Programmable Terminal Software User’s Manual (V118)



5   Objects
Additional Information

A recipe template is a defined data structure for a recipe.

5 A row is added. Make the following settings in the new row. Use the default values for other set-
tings.

Ingredient Name: Recipe1

Variable: intRecipe1

Default Value: 10

Min Value: 0

Max Value: 100

Set Recipe2 as follows:

Ingredient Name: Recipe2

Variable: intRecipe2

Default Value: 20

Min Value: 0

Max Value: 100

6 Right-click in the grid and select Show Recipes from the menu.

7 Right-click in the grid and select Add from the menu.

Additional Information

Recipes make settings in advance that are actually set according to the data structure.
5 - 18 NA Series Programmable Terminal Software User’s Manual (V118)



5   Objects
5-2  E

xam
p

les o
f U

sin
g

 O
b

jects

5

5-2-4  U
sing a R

ecipe
8 A row is added. Make the following settings in the new row. Use the default values for other set-
tings.

Recipe Name: RecipeSample1

Recipe1: 30

Recipe2: 40

Recipe Name: RecipeSample2

Recipe1: 50

Recipe2: 60

9 Create a button to transfer the recipe.

Right-click HMI - Pages- Page0 in the Multiview Explorer and select View Code from the menu.

10 Create the following subroutine.

11 Double-click HMI - Pages - Page0 in the Multiview Explorer. Drag a Recipe Viewer object from 
HMI Controls in the Toolbox to the page.
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12 Then drag a Button object from Buttons in the Toolbox to the page and set the following event 
and action.

Transfer the project to the HMI and confirm the operation.

When the button is touched, the values that are set for the specified recipe should be written to 
the connected device.
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This section describes how to go online with an HMI.
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Connecting to the HMI
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6-1 Introduction

You must go online with the HMI or connect to the Simulator to communicate with it from the Sysmac 
Studio.

The Sysmac Studio supports the following online connections for different applications.

Additional Information

Refer to 7-1-4 Offline Debugging with Only the HMI Simulator on page 7-6 for information on 
connecting to the Simulator and debugging operations.

Connecting to the HMI

Online connection Connection made to Application

Online connection The actual HMI To perform debugging, startup, or normal maintenance, the 
same project as in the actual HMI is opened on the Sysmac 
Studio and then an online connection is made. An online con-
nection is made based on the Communications Setup in the 
project.

Simulator connection

HMI Simulator The Simulator is used to debug the program offline. The Com-
munications Setup in the project is not used.
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6-2 Going Online with an HMI

You can simultaneously go online with more than one HMI in a project from the Sysmac Studio. The 
operations that are described in this section apply to the currently selected HMI. If there is more than 
one HMI registered in the project, confirm the HMI to operate before connecting to it.

Precautions for Correct Use

Do not reconnect the USB cable for at least 10 seconds after you disconnect it. After you con-
nect the USB cable, do not disconnect it until Windows detects the connection.

It may become impossible for Windows to detect when the cable is connected or disconnected, 
which would effectively disable the USB port. If that occurs, restart the computer. Otherwise, 
you will not be able to use the USB device until Windows recovers from the suspended status.

To go online with an HMI, there are three connection methods that can be used. These are described in 
the following table.

6-2-1 Methods for Going Online with an HMI

Connection method Connection diagram Description

Direct connection via 
USB

The USB port on the computer is 
connected directly to the USB slave 
port on the HMI.

This is the default connection con-
figuration.

Direct connection via 
Ethernet

The Ethernet port on the computer 
is connected directly to Ethernet 
port 2 on the HMI.

Ethernet connection 
via hub

The Ethernet port on the computer 
is connected through the Ethernet 
network to an Ethernet port on the 
HMI.
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You must set the connection method, IP address to connect to, and other parameters for communica-
tions between the computer and HMI.

1 Select Communications Setup from the HMI Menu.

The Communications Setup Dialog Box is displayed.

2 Select the connection method for the connection configuration in the Connection Type Field.

For an Ethernet connection via a hub, enter the IP address of the HMI to which you need to con-
nect in the Remote IP Address Area. Select any required options and enter the communications 
time-out time if required.

Note Refer to Communications Setup Dialog Box Settings on page 6-5 on the next page for information on 
the settings.

3 Click the OK Button.

This concludes the settings.

6-2-2 Setting the Connection Method
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 Communications Setup Dialog Box Settings

Use the following procedure to place the Sysmac Studio online with the HMI.

1 Select Online from the HMI Menu. Or, click the Go Online Button ( ) in the toolbar.

The following message is displayed the first time you go online. After you write the project 
name, this message is not displayed.

Additional Information

The same message will be displayed the next time you connect if the HMI device name that is 
set in the project is different from the HMI device name that is set in the HMI.

2 Click the Yes Button.

The Sysmac Studio goes online and the color of the bar at the top of the Edit Pane changes to 
yellow.

Item Description

Connection Type Select the connection port to use to go online.

The selected method is normally used to go online.

Remote IP Address If you specify an Ethernet hub connection, set the IP address of the HMI that you will 
connect to. Also, you can click a test button to perform a communications test.

Test USB Connec-
tions

Click the test button to perform a USB communications test.

Options Confirm serial ID when 
going online.

If you select this option, the names and serial IDs are 
compared between the project and the HMI when you 
go online to make sure that a connection is made to the 
intended HMI.

Communications 
time-out

You can set the response monitoring time for communications with the HMI.

An error is displayed if a response is not received before this time expires.

*1. The time can be set to between 1 and 3,600 s.

6-2-3 Online Connection
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Use the following procedure to go online if you selected the option to select the connection method 
whenever you connect the computer with the HMI in the Communications Setup Dialog Box.

1 Select Online from the HMI Menu. Or, click the Go Online Button ( ) in the toolbar.

The Communications Setup Dialog Box is displayed.

The IP address that is set in the Communications Setup Dialog Box is displayed below the 
Ethernet connection via a hub Option.

2 Select the connection method and then click the OK Button.

The Sysmac Studio goes online.

Use the following procedure to go offline.

Select Offline from the HMI Menu. Or, click the Go Offline Button ( ) in the toolbar.

The Sysmac Studio goes offline.

The serial ID is verified when going online if the option to do so was selected in the Communications 
Setup Dialog Box. If the serial ID of the project on the Sysmac Studio is different from that of the HMI, 
the following confirmation dialog box is displayed when you attempt to go online.

1 Click the Yes Button.

The serial ID of the project on the Sysmac Studio is rewritten to the same value as that of the 
HMI.

6-2-4 Going Online after Checking the Connection Method

6-2-5 Going Offline

6-2-6 Confirming Serial IDs
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Precautions for Correct Use

• If a USB connection is used, an Ethernet IP address of 192.168.255.xxx is used internally. 
When using a USB connection, do not use an IP address of 192.168.255.xxx for the Ethernet 
interface card in the computer.

• Socket ports 9600 and 2224 are used for Ethernet UDP/IP communications. When using 
Ethernet UDP/IP communications, do not use these ports for any other application.

• When using a direct Ethernet connection and there is more than one Ethernet interface card 
mounted in the computer, you must select the Ethernet interface card to use. Refer to the 
Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for specific selection proce-
dures.
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This section describes offline debugging using the HMI Simulator.

7-1 HMI Debugging Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-2
7-1-1 Watch Tab Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-2

7-1-2 Breakpoints . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-3

7-1-3 Step Execution  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-4

7-1-4 Offline Debugging with Only the HMI Simulator  . . . . . . . . . . . . . . . . . . . . . . . . 7-6

7-1-5 Offline Debugging with the Controller Simulator . . . . . . . . . . . . . . . . . . . . . . . . 7-7

Debugging
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7-1 HMI Debugging Functions

The operations you can use for debugging on the Sysmac Studio are listed below. The HMI Simulator is 
used for offline debugging. You can use the HMI Simulator by itself, or you can connect it to the Control-
ler Simulator to debug the entire system.

The following three functions are provided for debugging during HMI simulations. These functions are 
the same regardless of whether they are used in offline debugging.

• Watch Tab Page

• Breakpoints

• Step execution

The basic Sysmac Studio operations of the Watch Tab Page apply to HMIs.

Refer to the Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for details.

However, the following differences exist for HMI projects.

• You can monitor the following variables on the Watch (Project) Tab Page.

• The Watch Tab Page functions only for the Simulator. Even if you are online with the physical HMI, 
you cannot monitor the variables in the physical HMI.

• You can monitor values in the Watch Tab Page only when the project is paused at a breakpoint. Val-
ues are not displayed under any other conditions.

• A red box is displayed for variables registered in the Watch Tab Page if the values cannot be 
obtained, such as when not pausing at a breakpoint.

Although the Simulator simulates the operation of the HMI, there are differences from the 
HMI in operation and timing. After you debug operation with the Simulator, always check 
operation on the actual Controller and HMI before you use them in the actual system. Acci-
dents may occur if the controlled system performs unexpected operation. Refer to A-3 Dif-
ferences between the Physical HMI and Simulator on page A-5 for details on differences in 
operation.

Although offline debugging simulates the integrated operation of the HMI and Controller, 
there are differences in operation and timing in comparison with combining the actual HMI 
and Controller. After you debug operation with the simulation, always check operation on 
the actual Controller and HMI before you use them in the actual system. Accidents may 
occur if the controlled system performs unexpected operation. Refer to A-3 Differences 
between the Physical HMI and Simulator on page A-5 for details on differences in opera-
tion.

7-1-1 Watch Tab Page

Standard projects: Only global variables can be registered. You can continuously monitor any of 
the global variables. Register the variable names as they are.

IAG projects: You can register only user-defined variables. You can monitor only the 
user-defined variable in the IAG when execution is paused for a breakpoint. 
Register variable names in the following format: Me.Variable_name.

Caution
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You can set breakpoints in the source code of a subroutine. You can use breakpoints to pause the exe-
cution of a subroutine at any desired point.

 Setting Breakpoints

You can set breakpoints to pause execution of a simulation, e.g., to see the status after a subroutine 
is executed.

 Procedure

To set a breakpoint, move the cursor to the line in the subroutine where you want to set the break-
point and select Set/Clear Breakpoint from the Simulation Menu.

If you repeat this operation, the breakpoint will be cleared.

You can clear all of the breakpoints at the same time.

Select Clear All Breakpoints from the Simulation Menu to clear all of the breakpoints.

7-1-2 Breakpoints

Setting and Clearing Breakpoints

Clearing All Breakpoints
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You can use step execution when subroutine execution is paused at a breakpoint to trace operation one 
line of the source code at a time.

You can use step execution to execute the source code of a subroutine one line at a time.

If you select Step In and other commands from the Simulation Menu while paused at a breakpoint dur-
ing a simulation, you can control execution one line or one function at a time.

The Step Execution command executes one function at a time.

Select Step Execution from the Simulation Menu when subroutine execution is paused during step-in 
execution.

Step-in execution performs step execution for the source code of a subroutine.

When you execute a program through the Simulator, select Simulation - Step In when the subroutine 
is stopped at a breakpoint, paused, or stopped during step execution.

7-1-3 Step Execution

Step Execution

Step Execution

Step-in Execution
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Use the Step Out command to exit a subroutine during step-in execution.

Select Step Out from the Simulation Menu during step-in execution.

The Continue command executes the subroutine to the next breakpoint.

Select Continue from the Simulation Menu when subroutine execution is paused during step-in execu-
tion.

Step-out Execution

Continue
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7   Debugging
Before you check the entire system, you can perform debugging with the HMI Simulator alone.

When you create a project and want to debug it, always check operation with only the HMI Simulator 
first. The Sysmac Studio comes with a Simulator that simulates HMI functions.

Use the following procedure to start the Sysmac Studio and perform debugging.

1 Start the Sysmac Studio and create a project.

2 Create the HMI application.

3 Select Build HMI from the Project Menu to build the project.

4 Select Start NA Simulation from the Simulation Menu.

The Simulator starts.

Additional Information

If the project is not yet built, it is built automatically.

7-1-4 Offline Debugging with Only the HMI Simulator

Procedure
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5 To stop the simulation, click Stop NA Simulation from the Simulation Menu. The HMI Simulator 
is ended.

You can perform debugging with the HMI Simulator connected online to the Controller Simulator. This 
allows you to debug the project while the Controller program is actually running.

After you complete checking operation with the HMI Simulator alone, check operation that includes the 
Controller program. The Sysmac Studio enables integrated debugging of the Controller program and 
the HMI application by connecting the Controller Simulator to the HMI Simulator.

You can perform debugging with the HMI Simulator and Controller Simulator connected when either the 
HMI or the Controller is selected, but the restrictions depend on which is selected, as described below. 
You cannot change a device while debugging is in progress.

• Starting When the HMI Is Selected

You cannot use the debugging functions and Simulator control functions of the Controller. The only 
Controller debugging function you can use is monitoring in the Watch Tab Page.

• Starting When the Controller Is Selected

You cannot use the debugging functions of the HMI. The only HMI debugging function you can use is 
monitoring in the Watch Tab Page.

7-1-5 Offline Debugging with the Controller Simulator
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Synchronization is used to transfer the project from the Sysmac Studio to the HMI.

1 Start the Sysmac Studio and create a project.

2 Create the Controller program.

3 Create the HMI application.

4 Select Build HMI from the Project Menu to build the project.

5 Select Run with Controller Simulator from the Simulation Menu.

Additional Information

If there is more than one Controller in the project, the window will be displayed for the Controller 
that is currently connected. If you select a Controller for which variables are not mapped, an 
error will occur and starting the Simulator will be canceled.

The Controller Simulator is started and the HMI Simulator is displayed.

Additional Information

If the project is not yet built, the entire project including the Controller is built automatically. If a 
building error occurs for the Controller, a dialog box is displayed to notify you of the error. 
Change the device to the relevant Controller, build the project, and check the error.

Procedure
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6 To stop the simulation, click Stop NA Simulation from the Simulation Menu. The Controller 
Simulator and the HMI Simulator are stopped.

Additional Information

You can also start online debugging when the Controller is selected in the project. Refer to the 
Sysmac Studio Version 1 Operation Manual (Cat. No. W504) for details.
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This section describes how to synchronize the projects between the HMI and the Sys-
mac Studio.

8-1 Synchronizing Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-2

8-2 Using Storage Media for Synchronization . . . . . . . . . . . . . . . . . . . . . . . . . . 8-5

Synchronizing Projects
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8-1 Synchronizing Projects

Synchronization is used to transfer the project from the Sysmac Studio to the HMI.

The basic Sysmac Studio operations for synchronization generally apply to HMIs. Refer to the Sysmac 
Studio Version 1 Operation Manual (Cat. No. W504) for details.

This section describes differences in synchronization when an HMI is selected.

Precautions for Safe Use

Unexpected operation may result if you set inappropriate network configuration settings. Even 
if appropriate network configuration settings are set, confirm that the controlled system will not 
be adversely affected before you transfer the data.

Precautions for Correct Use

Do not perform any other operations on the Sysmac Studio while the Synchronization Window 
is active. An error will occur and synchronization will fail.

Sufficiently check the operation of any project that you create before you start actual system 
operation.

WARNING
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The following differences exist in synchronization when an HMI is selected.

• Detailed comparison is not supported.

• Algorithm checking is not supported. Therefore, there is no way to prevent mismatches in build dates 
that result from rebuilding.

• Uploading is not supported.

• You can download only executable files, i.e., only built files.

Therefore, you cannot recover a project from the data in the HMI. Always manage projects on the 
computer.

• You must download the entire project to the HMI at the same time. You cannot download smaller 
units of project data.

• If the project version specified in the project is newer than the version of the project in the HMI, the 
runtime files will always be transferred.

• You can transfer the system program. The system program is automatically transferred when other 
data is downloaded if updating the system program is necessary.

• The following synchronization options are provided.

The following differences apply to the comparison results.

 Verification Results Example

The verification results are displayed as shown in the following example.

Functional Differences When an HMI Is Selected

Option Default
When trans-

fer is enabled
Description

Clear the present values of 
variables with Retain attribute.

Selected. Values written 
to HMI

If this check box is selected, the present val-
ues of Retain variables are cleared after the 
data is downloaded.

Clear alarm log data from 
memory

Selected. Values written 
to HMI

If this check box is selected, the alarm log in 
non-volatile memory is cleared. If you have 
changed the user alarm settings, you cannot 
clear the selection of this check box.

Clear Data log data from 
memory

Selected. Values written 
to HMI

If this check box is selected, the data log 
data in non-volatile memory is cleared. If you 
have changed the data logging settings, you 
cannot clear the selection of this check box.

Differences in Comparison Results

Column Item

Source Project name on the Sysmac Studio

Source Modified Date The last time that the project was built on the Sysmac Studio

Target Modified Date The last time that the HMI project was built on the Sysmac Studio

Target HMI project name

Detailed Comparison This column is not used when an HMI is selected.
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 Verification Units

The units for comparison that are shown in the Synchronization Window are listed in the following 
table.

Synchronization data name Level Qty
Detailed 

comparison
Remarks

HMI name 1 1 None

Project 2 1 None

Pages 3 1 None

Page* 4 N None

Subroutines 3 1 None

SubroutineGroup* 4 N None

Variables 3 1 None

Global Events 3 1 None

Alarms 3 1 None

Data logging 3 1 None

Recipe Template 3 1 None

Data 3 1 None

User Accounts 4 1 None

Recipe Instances 4 N None

Settings 3 1 None

HMI Settings 4 1 None

Security Settings 4 1 None

Resources 3 1 None

Runtime Files 3 1 None
8 - 4 NA Series Programmable Terminal Software User’s Manual (V118)



8   Synchronizing Projects
8-2  U

s
in

g
 S

to
rag

e M
e

d
ia fo

r S
yn

ch
ro

n
izatio

n

8

  
8-2 Using Storage Media for Synchroni-
zation

With an HMI, you can perform product synchronization with storage media.

1 Insert an SD Memory Card or USB memory device into the computer.

2 Select Transfer to Media Device from the HMI Menu.

3 Select the folder to use for synchronization and click the OK Button.

4 The project on the Sysmac Studio is compared with the project in the storage media and the 
Synchronization Window is displayed.
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5 Click the Transfer to Device Button to transfer the project to the storage media.

6 Insert the storage media into the HMI, display the Device System Menu, and touch the Transfer 
Operations Button.

7 Touch the Transfer User Program to HMI Button.

8 Select the project to transfer and touch the Transfer to HMI Button to download the selected 
project to the HMI.
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This section describes how to reuse objects.
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9-1 Reusing Objects

The Sysmac Studio provides the following two functions to simplify and increase the speed of the devel-
opment of HMI applications.

• Intelligent application gadgets (IAGs)

• Custom objects

IAGs and custom objects are different in the following ways.

• You can distribute IAGs to other parties. You can use custom objects only on the Sysmac Studio.

• You must treat IAGs as IAGs even after you place them on pages. You treat custom objects like any 
other objects after you place them on pages.

• After you place an IAG on a page, you can change only the properties of the IAG objects. You can 
change any of the attributes of custom objects.

• You can hide the contents of subroutines in IAGs. Therefore, you can provide IAGs to other parties 
without disclosing technology.

You can customize objects yourself and create reusable objects that combine other objects.
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9-2 IAGs

An IAG is a library object that you can distribute to other parties. To create a new IAG, you must create 
it in an IAG project. This section describes the procedures to create and use IAGs.

Even when an IAG project is selected, basic operations are generally the same as for a standard proj-
ect. However, the following items are different.

The structure of the Multiview Explorer when you select an IAG project is shown below. You can edit the 
user-defined variables, subroutines, and other resources in an IAG from the menu that is displayed 
when you right-click the IAG.

9-2-1 Differences when an IAG Project Is Selected

Layers and Items in the Multiview Explorer

Configurations and Setup HMI

Language Settings IAGs

IAG Collection Settings Resources
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This section describes the differences in the Toolbar compared with a standard project.

 Insert Menu

 Project Menu

You can set the languages to use in the IAG.

Toolbar

Item Description Remarks

IAG Inserts a new IAG in IAGs.

Item Description Remarks

Build IAGs Builds all of the IAGs.

Publish IAG Collection Saves an IAG collection in a file format that you can use in a standard project.

Language Settings

Symbol Item Description Remarks

(a) Default language Sets the language that is selected by default.

(b) Defined Languages Displays the languages that you select.

(c) >
This button moves a selected language to the defined 
language list.

(d) <
This button deletes a selected language from the 
defined language list.

(e) Available Languages Displays the languages that you can select.

(a)

(b)

(c)

(e) (d)
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You can make the following settings for an IAG collection.

The following tab page is used to create an IAG. The procedures are generally the same as for standard 
projects, except for the following differences.

• There are no global variables. Only local variables for each IAG can be used.

• You cannot set page animations, and you cannot set page events and actions.

• You cannot use functions that cannot be placed on a page, such as global events and recipes.

• You cannot use Trend Graph objects and user-created IAGs.

IAG Collection Settings

Symbol Item Description Remarks

(a) Name Sets the name.

(b) Version Sets the version.

(c) Description Sets a description.

(d) Publisher Sets the publisher.

(e) Visible By Default
Select this check box to display the IAG collection 
in the Toolbox when the IAG collection is imported 
into the Sysmac Studio.

IAGs

(a)
(b)
(c)

(d)
(e)
9 - 5NA Series Programmable Terminal Software User’s Manual (V118)



9   Reusing Objects
You can set the resources to use in the IAG. The procedures are the same as for a standard project.

This section describes how to create an IAG.

The size of the IAG will be the size of the page when the IAG is created. Any objects that are positioned 
outside of the page are ignored.

1 Create a new project and set the project type to IAG Project.

Resources

9-2-2 Creating an IAG

Set Type to IAG Project.
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2 Click the Create Button.

An IAG project is created and the following window is displayed.

3 Create the IAG with the same methods as for a normal page.

4 Select Build IAGs from the Project Menu.
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5 Select Publish IAG Collection from the Project Menu.

6 Click the Browse Button (...) and specify where to save the collection.

7 Click the Publish Button. The IAG collection is created.
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This section describes how to use the IAGs that you create when you edit a standard project.

To use IAGs, you must first register them in the Toolbox. After you register them in the Toolbox, you can 
drag them to the page to use them in the same way as for other objects.

1 Select IAG Collections Manager from the Project Menu.

2 Click the + Button. Select the IAG file and click the Open Button.

9-2-3 Using IAGs

Registering IAGs
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3 Select the Show in Toolbox Check Boxes for the IAG collections that you want to display in the 
Toolbox. 

4 The IAGs for the selected check boxes are displayed in the Toolbox.
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9-3 Custom Objects

You can register the objects that you use most frequently to increase your productivity. This section 
describes the procedures to create and use custom objects.

An object must meet the following conditions before you can register it as a custom object.

• You can register only individual objects.

You cannot register more than one object as a custom object. If you want to register more than one 
object as a custom object, group the objects into one object first.

• The object cannot be a user-defined IAG.

You cannot register a user-defined IAG or a group that contains a user-defined IAG as a custom 
object.

Use the following procedure to create a custom object.

1 Create a standard project and place the objects to register as a custom object on the page.

9-3-1 Objects That You Can Register as Custom Objects

9-3-2 Creating Custom Objects
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2 Group the objects to register the group as a custom object.

3 Right-click the group of objects and select Add to Toolbox from the menu.
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4 The group is added as a custom object under Custom in the Toolbox. The displayed name is 
the name of the registered group or object.
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Use the following procedure to delete a registered custom object.

1 Right-click the custom object to delete from the Toolbox. Select Delete from the menu.

2 A confirmation dialog box is displayed. Click the Yes Button.

9-3-3 Deleting Custom Objects
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It is very easy to use a custom object. Just select the desired custom object in the Toolbox and drag it to 
the page. You can handle the custom objects on pages in the same ways as you handle normal objects.

9-3-4 Using Custom Objects
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This section describes how to connect to an HMI from an external device.

10-1 Accessing an HMI from an External Device  . . . . . . . . . . . . . . . . . . . . . . . 10-2
10-1-1 VNC  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-2

10-1-2 FTP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-3

Connecting to HMIs from External 
Devices
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10-1 Accessing an HMI from an External 
Device

You can use the following two methods to access an NA-series Programmable Terminal from an exter-
nal device.

• Remote monitoring and control with VNC

• File operations with FTP

Precautions for Correct Use

• Only password security is provided for using VNC and FTP. Sufficiently consider the network 
configuration in terms of security and implement any required measures to prevent unauthor-
ized access.

• Use the same keyboard layout settings for the VNC client computer and the HMI. If the set-
tings are not the same, different characters may results from the characters input from the 
VNC client.

You can enable VNC to use a VNC client to monitor and control HMI pages. You can also use a mode 
setting to prohibit controlling operation from a VNC client and allow only monitoring.

Double-click HMI Settings under Configurations and Setup. Click the VNC Settings Button.

Select the Use Option for Enable VNC and change the setting of the Mode Box as required. Set a text 
string in the Password Box.

After you complete the settings, select Build HMI from the Project Menu. When building the project is 
completed, download the project to the HMI. 

10-1-1 VNC

Setting Method
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After the download is completed, you can access the HMI from a VNC client.

Additional Information

Refer to the relevant software manuals for the operating procedures of the VNC client.

You can enable the FTP server to use an FTP client to access files in the HMI. However, you can 
access only specific folder.

Double-click HMI Settings under Configurations and Setup. Click the FTP Settings Button.

Select the Use Option. Set text strings for the login name and password.

After you complete the settings, select Build HMI from the Project Menu. When building the project is 
completed, download the project to the HMI. 

After the download is completed, you can access the HMI from an FTP client.

Additional Information

Refer to the relevant software manuals for the operating procedures of the FTP client.

10-1-2 FTP

Setting Method
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This section describes other functions that the Sysmac Studio provides for HMIs.

11-1 Sysmac Studio Option Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-2

Other Functions
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11-1 Sysmac Studio Option Settings

The following Sysmac Studio option settings are related to HMIs.

• HMI Code Editor

• HMI Page Editor

You can make settings to highlight text in the HMI Code Editor.

HMI Code Editor

Symbol Item Description Remarks

(a) Color Selections Select the color for each item.

(b) Reset to default settings This button resets the colors to the 
default settings.

(b)

(a)
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You can make settings for the grid in the HMI Page Editor.

HMI Page Editor

Symbol Item Description Remarks

(a) Grid Settings Make the settings for the grid.

(b) Reset to Defaults This button restores the default grid 
settings.

(b)

(a)
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The appendices provide information on supported file formats and other information.

A-1 Events and Actions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-2

A-2 Supported Formats  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-4

A-3 Differences between the Physical HMI and Simulator  . . . . . . . . . . . . . . . . A-5

Appendices
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A-1 Events and Actions

Events

Name Description
Global 
events

Page Objects
User 

alarms

Acknowledged
The event occurs when the user alarm is acknowl-
edged.

― ― ― Yes

Checked The event occurs when the check box is selected. ― ― Yes ―

Cleared The event occurs when the user alarm is cleared. ― ― ― Yes

Click*1 The event occurs when the object is tapped. ― ― Yes ―

Condition The event occurs when the set condition is met. Yes Yes ― ―

F1 Key Click*1

*1. For both Click and Release, the event occurs when the object is released, but the operation when the page is 
changed is different. If the page changes when an object set for Click is touched but not yet released, the event 
does not occur. If the page changes when an object set for Release is touched but not yet released, the event 
does occur.

The event occurs when the F1 Key is tapped. Yes Yes ― ―

F1 Key Press The event occurs while the F1 Key is held down. Yes Yes ― ―

F1 Key Release*1 The event occurs when the F1 Key is released. Yes Yes ― ―

F2 Key Click*1 The event occurs when the F2 Key is tapped. Yes Yes ― ―

F2 Key Press The event occurs while the F2 Key is held down. Yes Yes ― ―

F2 Key Release*1 The event occurs when the F2 Key is released. Yes Yes ― ―

F3 Key Click*1 The event occurs when the F3 Key is tapped. Yes Yes ― ―

F3 Key Press The event occurs while the F3 Key is held down. Yes Yes ― ―

F3 Key Release*1 The event occurs when the F3 Key is released. Yes Yes ― ―

Interval The event occurs at the specified interval. Yes ― ― ―

Page Displayed The event occurs when the page is displayed. ― Yes ― ―

Page Hidden The event occurs when the page is hidden. ― Yes ― ―

Press The event occurs while the object is held down. ― ― Yes ―

Project Initialization*2

*2. The results of accessing external variables during project initialization immediately after startup are not always 
dependable. Do not access external variables during project initialization.

The event occurs when the project is initialized. Yes ― ― ―

Raised The event occurs when the user alarm occurs. ― ― ― Yes

Release*1 The event occurs when the object is released. ― ― Yes ―

Selection Changed
The event occurs when the item selected in the 
list changes.

― ― Yes ―

Unchecked
The event occurs when the check box selection is 
cleared.

― ― Yes ―
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Actions

Action Description
Global 
events

Page Objects
User 

alarms

CallSubroutine
Executes a subroutine registered as a 
global subroutine or page subroutine. Yes*1

*1. You cannot execute page subroutines for global events or user alarms.

Yes Yes Yes*1

ClearUserAlarmLog Clears the user alarm log. Yes Yes Yes Yes

ClosePage Closes the specified page. Yes Yes Yes Yes

DecreaseVariable
Subtracts the specified value from the spec-
ified variable.

Yes Yes Yes Yes

EjectSDMemory Enables removing the SD Memory Card. Yes Yes Yes Yes

EnableInputOperation
Enables or disables inputs on the touch 
panel.

Yes Yes Yes Yes

IncreaseVariable
Adds the specified value to the specified 
variable.

Yes Yes Yes Yes

InvertVariable
Inverts the value of the specified Boolean 
variable.

Yes Yes Yes Yes

Login Displays the login page. Yes Yes Yes Yes

Logout Logs out the user. Yes Yes Yes Yes

ResetVariable
Changes the value of the specified Boolean 
variable to False.

Yes Yes Yes Yes

SaveUserAlarmLog-
ToFile

Saves the user alarm log to a file. Yes Yes Yes Yes

SetBrightness Changes the brightness of the screen. Yes Yes Yes Yes

SetLanguage Changes the project language settings. Yes Yes Yes Yes

SetVariable
Sets the value of the specified variable to a 
specified value.

Yes Yes Yes Yes

ShowDocu-
ment(FULL SCREEN)

Displays a PDF or other file full screen. Yes Yes Yes Yes

ShowDocument(Win-
dow)

Displays a PDF or other file in a window. Yes Yes Yes Yes

ShowPage*2

*2. If you execute an action with a Momentary Button, use a Click or Release event.

Displays a page. Yes Yes Yes Yes

ShowPreviousPage*2 Displays the most recently displayed page. Yes Yes Yes Yes

ShowSystemMenu Displays the System Menu. Yes Yes Yes Yes

StartDataLogging Starts data logging. Yes Yes Yes Yes

StopDataLogging Stops data logging. Yes Yes Yes Yes
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A-2 Supported Formats

The HMI objects support the following formats. However, it may not be possible to display some files 
even if the file format is supported.

The following formats are supported.

The following formats are supported. However, only progressive formats are supported.

The Document Viewer can display the following files.

Image Files

Format name
Exten-
sion

Specifications

Microsoft Windows Bit-
map Image

BMP 1, 4, 8, 16, 24, or 32-bit

Uncompressed or RLE compression

Graphics Interchange 
Format

GIF 1, 4, or 8-bit

Transparent GIF or interlaced GIF

JFIF or EXIF JPG 8-bit gray scale

24-bit/basic DCT or progressive DCT

Portable Network Graph-
ics

PNG 1, 4, 8, or 24-bit

Transparency is supported.

Video

Format name
Exten-
sion

Specifications
Maximum 
resolution

MPEG-1 mpg The MPEG-1 Video Stream format is not supported. 768×480

MPEG-2 mpg Main Profile Low, Main, and High 1440

MPEG-2 TS is not supported.

1280×720

MPEG-4 Part 2 mp4 Simple Profile L0, L1, L2, and L3

Advanced Simple Profile L0, L1, L2, L3, L4, and L5

Global motion compensation is not supported.

1280×720

MPEG-4 Part 10 
(H.264)

mp4 Baseline Profile L1, L1.2, L1.3, L2, L2.2, and L3

Main Profile L1, L1.2, L1.3, L2, L2.2, L3, L3.1, L3.2, and L4.1

High Profile L1, L1.2, L1.3, L2, L2.2, L3, L3.1, L3.2, and L4.1

1280×720

Windows Media Video wmv WMV9 240×160

Files Supported by Document Viewer

Format name
Exten-
sion

Specifications

Adobe Acrobat Document PDF

Microsoft Excel Books xlsx

Microsoft Excel 97-2003 Books xls

Microsoft Word Documents docx

Microsoft Word 97-2003 Docu-
ments

doc
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A-3 Differences between the Physical HMI 
and Simulator

The following differences exist between the physical HMI and Simulator.

• Trend Graph Objects

The Simulator cannot display graphs. Only the frames are displayed.

• Media Player Objects

Although the Simulator will execute more than one Media Player object on the same page, the phys-
ical HMI never executes more than one.

• ShowDocument Action and ShowDocument Function

The Simulator ignores parameters that specify the display positions and sizes for documents. To dis-
play documents, there must be a compatible application, such as Adobe Reader. The application 
used to display a document will not be exited when the Simulator is exited or the page is changed 
after the document is displayed. Exit the application manually.
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